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          Adobe Acrobat Reader 

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

            Choose Edit > Find Again 

            Reopen the find dialog box, and click Find Again. 
            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to
       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[There is no reportable action as a result of the

Board of Supervisors' closed session held today.]

SUP. ANTONOVICH, MAYOR: THE JANUARY 20TH MEETING OF THE LOS ANGELES COUNTY BOARD OF SUPERVISORS WILL BEGIN. FIRST WILL BE LED IN PRAYER BY PASTOR CHRIS PONNET, ST. CAMILLUS CENTER FOR SPIRITUAL CARE AND DIRECTOR OF SPIRITUAL CARE AT THE LAC+USC MEDICAL CENTER. OUR PLEDGE OF ALLEGIANCE WILL BE LED BY DAVID WILLIAM TAGGART, JR., FORMER SPECIALIST UNITED STATES ARMY. PASTOR? 

FR. CHRIS PONNET: MAY WE TAKE A MOMENT OF SILENCE IN THE PRESENCE OF THE DIVINE? SOURCE OF HOPE, CONTINUE TO INSPIRE OUR SUPERVISORS AND THEIR STAFF WITH THE DESIRE IN THEIR HEARTS TO CONTINUE TO DELIBERATE WITH ACTION THAT HELP ALL WHO CALL LOS ANGELES HOME. TODAY AS WE RETURN TO THIS CHAMBER TO CONTINUE THE WORK OF REVEREND DR. MARTIN LUTHER KING JR., WHO IN 1967 SAID, "IT ALL BOILS DOWN TO THIS: THAT LIFE IS INTERRELATED. WE ARE ALL CAUGHT IN THE INESCAPABLE NETWORK OF MUTUALITY, TIED INTO A SINGLE GARMENT OF DESTINY. ". SOURCE OF PEACE, YOU MARCHED WITH YOUR PEOPLE FROM ISRAEL INTO THE PROMISED LAND WITH MAHATMA GANDHI TO THE SALT MINES OF INDIA AND REVEREND MARTIN LUTHER KING INTO SELMA AND OUR NATIONAL CAPITAL. LOS ANGELES OFTEN HOSTS MARCHES ON IMMIGRATION AND HUMAN RIGHTS, THIS WEEKEND THERE WAS A MARCH FOR LIFE AND YESTERDAY A MARCH TO LEIMERT PARK FOR JUSTICE. SOURCE OF PEACE, CONTINUE TO GUIDE US IN OUR MARCHING TOWARD JUSTICE. AS WE AS A COMMUNITY CONTINUE TO REMEMBER THOSE HEROES OF OUR COMMUNITY, RABBI LEONARD BEERMAN AND DR. MAHER HATHOUT WE ARE REMINDED THAT WE ARE ALL CALLED TO A PLACE OF NONVIOLENCE IN OUR WORLD. SOURCE OF WISDOM, MAY OUR HOMES, OUR NEIGHBORHOODS AND OUR BELOVED COUNTY BE A PLACE OF AFFIRMATION AS ONE OF THE CHAPLAINS AT LAC+USC MEDICAL CENTER WE DAILY WALK AND ACCOMPANY PEOPLE IN OUR COUNTY WITH MEDICAL AND OTHER NEEDS. WE ARE THERE TO LISTEN, TO AFFIRM AND TO INVITE DEEPER REFLECTION. AND AS POPE FRANCIS SAID THIS WEEKEND, "WE AS A WORLD NEED TO LEARN HOW TO CRY WITH THE POOR OR THE HUNGRY AND THE ABANDONED." AND SO, GRACIOUS ONE, MAY THIS CHAMBER BE A SOURCE OF DEEPER REFLECTION SO THAT DECISIONS WILL HELP THE MOST VULNERABLE SINCE WE ARE ALL TIED INTO A SINGLE GARMENT OF DESTINY. BLESSINGS. 

DAVID W. TAGGART, JR.: PLEASE CONTINUE STANDING FOR THE PLEDGE OF ALLEGIANCE. PLACE YOUR HAND OVER YOUR HEART AND FACE THE FLAG. [PLEDGE OF ALLEGIANCE RECITED.] 

SUP. ANTONOVICH, MAYOR: SUPERVISOR SOLIS? 

SUP. SOLIS: THANK YOU FOR THE OPPORTUNITY TO PRESENT TO PASTOR CHRIS PONNET THIS BOARD PRESENTATION THIS AFTERNOON. I WANT TO THANK HIM FOR LEADING THE INVOCATION TODAY. I WANT TO NOTE THAT PASTOR CHRIS WAS BORN AND RAISED IN SOUTHERN CALIFORNIA, IN TEMPLE CITY. HE CURRENTLY SERVES, AS YOU KNOW, AS DIRECTOR OF SPIRITUAL CARE AT THE LAC+USC MEDICAL CENTER AND IS PASTOR AT ST. CAMILLUS CENTER FOR SPIRITUAL CARE. BEYOND HIS ROLE AS RELIGIOUS LEADER, PASTOR CHRIS HAS ENGAGED IN CIVIL DISOBEDIENCE DEMONSTRATIONS AGAINST SOCIAL INJUSTICE. HE HAS SPOKEN NATIONALLY AND LOCALLY ON HIV AND AIDS, THE DEATH PENALTY, AND SOCIAL JUSTICE. HE HAS ALSO SERVED AS A REPRESENTATIVE FOR THE L.G.B.T. ISSUES HOSTING THE GAY AND LESBIAN MINISTRY OF THE ARCHDIOCESE AT ST. CAMILLIUS. THANK YOU SO MUCH, PASTOR. [APPLAUSE.] 

SUP. KNABE: SUPERVISOR SOLIS, IF I COULD JUST ADD, OF HIS MANY ACCOMPLISHMENTS, ONE THAT I HAVE MOST INTIMATELY BEEN INVOLVED IN IS EACH AND EVERY YEAR, HE LEADS A SERVICE FOR THE MASS BURIAL FOR THOSE IN OUR COUNTY THAT HAVE NO ONE ELSE THAT WE DO. I'VE BEEN A MEMBER OF HIS TEAM FOR A NUMBER OF YEARS NOW. THANK YOU FOR THAT. THAT'S A VERY SPECIAL SERVICE. AND HE EXPANDED THAT PROGRAM TO WHERE IT'S A VERY MOVING EXPERIENCE. I THINK EVEN THE PRESS IS PAYING ATTENTION, FINALLY, TO THOSE. THIS YEAR WE BURIED 1,482 INDIVIDUALS WHO HAD NO ONE ELSE TO CLAIM THEM. SO THANK YOU. [APPLAUSE.] 

SUP. ANTONOVICH, MAYOR: I WOULD LIKE TO RECOGNIZE DAVID WILLIAM TAGGART, JR., RESIDENT OF ALHAMBRA, SERVED THE UNITED STATES ARMY. HE SERVED IN AFGHANISTAN. HE WAS IN THE ARMY BETWEEN 2009, 2004, OBTAINED THE RANK OF SPECIALIST. HE OBTAINED THE AFGHANISTAN CAMPAIGN MEDAL WITH THREE CAMPAIGN STARS, THE ARMY COMMENDATION MEDAL, THE NATO MEDAL, THE ARMY GOOD CONDUCT MEDAL AND THE NATIONAL DEFENSE SERVICE MEDAL, THE GLOBAL WAR ON TERRORISM SERVICE MEDAL, THE ARMY OF SERVICE RIBBON, OVERSEAS RIBBON, SECOND AWARD COMBAT ACTION BADGE AND HE IS MARRIED WITH TWO CHILDREN. ATTENDING SCHOOL AT GLENDALE COMMUNITY COLLEGE. GRADUATED ALHAMBRA HIGH SCHOOL, THE FIGHTING MATADORS. SO THANK YOU FOR COMING DOWN AND LEADING US. [APPLAUSE.] 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: GOOD AFTERNOON, MR. MAYOR AND MEMBERS OF THE BOARD. WE WILL BEGIN ON PAGE 4 FOR THE AGENDA OF THE COMMUNITY DEVELOPMENT COMMISSION. ITEM 1-D, A MEMBER OF THE PUBLIC REQUESTED THAT THIS ITEM BE HELD. ON PAGE 5, BOARD OF SUPERVISORS, ITEMS 1-8. ON ITEM 1, SUPERVISOR SOLIS REQUESTS THAT THE APPOINTMENT OF HELEN HERNANDEZ TO THE ARTS COMMISSION BE REFERRED BACK TO HER OFFICE AND THIS ALSO INCLUDES THE ADDITIONS AND POSTED ON THE SUPPLEMENTAL AGENDA. ON ITEM NO. 3, A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. ON ITEM NO. 6, SUPERVISOR SOLIS AND A MEMBER OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. ON ITEM NO. 8, A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. AND THE REMAINING ITEMS UNDER THE BOARD OF SUPERVISORS ARE BEFORE YOU. 

SUP. ANTONOVICH, MAYOR: OKAY. MOTION BY SUPERVISOR KUEHL. SECOND WITHOUT OBJECTION, SO ORDERED. 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: ON PAGE 7, CONSENT CALENDAR, ITEMS 9-36. ON ITEM NO. 11, A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. ON ITEM NO. 12, MEMBERS OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. AND ON ITEM NO. 13, THE DIRECTOR OF PUBLIC SOCIAL SERVICES REQUESTS THAT THIS ITEM BE REFERRED BACK TO THE DEPARTMENT. ON ITEM NO. 14, A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. ON ITEM 15, THE DIRECTOR OF HEALTH SERVICES REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JANUARY 27, 2015. ON ITEM NO. 19, SUPERVISOR KUEHL REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JANUARY 27, 2015. ON ITEM NO. 20, MEMBERS OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. ON ITEM NO. 23, MEMBERS OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. AND ON ITEMS 27 AND 28, A MEMBER OF THE PUBLIC REQUESTS THAT THESE ITEMS BE HELD. ON ITEM 29, THE SHERIFF REQUESTS THAT THIS BE CONTINUED ONE WEEK TO JANUARY 27, 2015. THAT WAS ITEM 29. ON ITEM NO. 32, THE SHERIFF ALSO REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JANUARY 27, 2015. AND THE REMAINING ITEMS UNDER THE CONSENT CALENDAR ARE BEFORE YOU. 

SUP. ANTONOVICH, MAYOR: OKAY. A MOTION BY SUPERVISOR MARK RIDLEY-THOMAS. SECOND WITHOUT OBJECTION, SO ORDERED. 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: ON PAGE 22, ORDINANCE FOR INTRODUCTION, ITEM NO. 37. I'LL READ IN THE SHORT TITLE FOR THE RECORD. THIS IS AN ORDINANCE FOR INTRODUCTION AMENDING COUNTY CODE TITLE 6, SALARIES, BY ADDING, DELETING AND CHANGING CERTAIN CLASSIFICATIONS AND NUMBERS OF ORDINANCE POSITIONS IN VARIOUS DEPARTMENTS. AND ON THIS ITEM, A MEMBER OF THE PUBLIC ALSO REQUESTS THAT IT BE HELD. ON ITEM NO. 38, THE INTERIM CHIEF EXECUTIVE OFFICER REQUESTS THAT ITEM BE CONTINUED THREE WEEKS TO FEBRUARY 10, 2015. AND THIS IS ON PAGE 23 UNDER SEPARATE MATTERS. ON ITEM 39, A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. AND ITEM 40 IS BEFORE YOU. 

SUP. ANTONOVICH, MAYOR: OKAY. MOTION BY SUPERVISOR DON KNABE. SECONDED WITHOUT OBJECTION, SO ORDERED. 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: ON PAGE 24, DISCUSSION ITEMS, ITEM 41, THE INTERIM CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED TO MARCH 31, 2015. 

SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR SOLIS, OF SECOND, WITHOUT OBJECTION, SO ORDERED. 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: ON PAGE 25, MISCELLANEOUS ADDITIONS TO THE AGENDA WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON THE SUPPLEMENTAL AGENDA. ON ITEM 42-A MEMBERS OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD AND ITEM 42-B, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JANUARY 27, 2015. AND ON PAGE 29, CLOSED SESSION. ON ITEM CS-1, A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. AND THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NO. 1. SUPERVISOR SOLIS? 

SUP. SOLIS: THANK YOU, MR. MAYOR. THIS MORNING, MEMBERS, I'D LIKE TO TAKE THIS OPPORTUNITY TO CALL UP LIZETTE SALAS. MRS. SALAS IS FROM THE CITY OF AZUSA AND IS A CHAMPION ON THE LADIES PROFESSIONAL GOLFERS ASSOCIATION, THE L.P.G.A. TOUR. THE YOUNGEST DAUGHTER OF MEXICAN IMMIGRANTS FROM ZACATECAS, LIZETTE'S RISE OF PROMINENCE IN THE WORLD OF GOLF IS A SOURCE OF PRIDE FOR HER FAMILY AND OUR LATINO COMMUNITY. SHE IS CURRENTLY RECOGNIZED AS ONE OF THE TOP 25 FEMALE GOLFERS IN THE WORLD BY ROLEX RANKINGS. LIZETTE GRADUATED FROM THE UNIVERSITY OF SOUTHERN CALIFORNIA AND AS MEMBER OF THE U.S.C. WOMEN'S GOLF TEAM, SHE WAS THEIR ONLY FOUR-TIME ALL-AMERICAN U.S.C. ATHLETE IN ANY SPORT. SHE WAS ALSO A TWO-TIME PAC TEN PLAYER OF THE YEAR IN 2009 AND 2011. LIZETTE WON HER FIRST L.P.G.A. TOURNAMENT MAY 17, 2014 AT THE L.P.G.A . KINGSMILL CHAMPIONSHIP IN WILLIAMSBURG, VIRGINIA AND WAS ONE OF THE 10 U.S. L.P.G.A. GOLFERS TO QUALIFY TO COMPETE IN THE UNITED STATES SOLHEIM CUP TEAM AGAINST THE EUROPEAN TEAM IN 2013. [APPLAUSE.] LIZETTE SHARES HER PASSION FOR GOLF WITH THE YOUTH OF HER COMMUNITY BY VOLUNTEERING WITH THE SAN GABRIEL JUNIOR GOLF PROGRAM WHICH WAS FOUNDED BY HER FATHER WHO IS HERE ALSO WITH US, WHO ALSO HAPPENED TO BE HER COACH WHEN SHE FIRST STARTED GOLFING. SHE SERVES AS A BOARD CHAIR NOW FOR AN ORGANIZATION THAT THEY PUT TOGETHER, KNOWN AS THE SAN GABRIEL JUNIOR GOLF PROGRAM AND SHE IS THE BOARD CHAIR AND ONE OF THE INSTRUCTORS IN THE PROGRAM. SHE IS THE FIRST MEXICAN AMERICAN ON THE L.P.G.A. TOUR SINCE GOLF LEGEND NANCY LOPEZ AND IS A ROLE MODEL TO EVERY YOUNG LATINA ASPIRING TO BECOME A PROFESSIONAL GOLFER, THAT INCLUDES ME, BECAUSE I DON'T GOLF; HOWEVER, I KNOW WHO I CAN GO TO FOR A LESSON. THIS WEEKEND, SHE IS BEING GIVEN THE "BREAKING THE GLASS CEILING" AWARD BY THE LATINA GOLFERS ASSOCIATION, WHO RECOGNIZES LATINAS THAT ARE MAKING AN IMPACT IN THEIR COMMUNITIES AND IN THEIR PROFESSIONAL CAREERS. ON BEHALF OF THE L.A. COUNTY BOARD OF SUPERVISORS, WE'D LIKE TO PRESENT THIS TO YOU, LIZETTE SALAS, FOR YOUR OUTSTANDING LEADERSHIP AND COMMITMENT TO OUR COMMUNITY AND FOR SERVING US SO PROUDLY. THANK YOU. [APPLAUSE.] 

LIZETTE SALAS: HELLO, EVERYONE. I JUST WANT TO THANK THE COUNTY OF LOS ANGELES, SUPERVISORS, EVERYONE HERE TODAY FOR THIS AMAZING HONOR. I'M SHAKING I'M SO NERVOUS. I'VE LIVED IN THE COUNTY OF L.A. ALL MY LIFE. I WENT TO SCHOOL DOWN THE ROAD AT U.S.C. I'M VERY PROUD TO REPRESENT NOT ONLY MY CITY OF AZUSA, MY FAMILY, BUT ALSO THE COUNTY OF L.A. THIS STATE, THIS COUNTY HAS MADE ME WHO I AM TODAY AND HOPEFULLY WE'LL HAVE MORE GIRLS FROM THE L.A. COUNTY ON THE L.P.G.A. TOUR AND WINNING CHAMPIONSHIPS. SO THANK YOU SO MUCH. 

SUP. SOLIS: THANK YOU, MR. MAYOR. I HAVE ANOTHER PRESENTATION TO MAKE. AND I'M PROUD TODAY TO ASK MEMBERS OF THE VET HUNTERS GROUP TO COME FORWARD. [APPLAUSE.] TODAY I HAVE THE PLEASURE OF RECOGNIZING A VERY INSPIRATIONAL ORGANIZATION WHOSE MEMBERS HAVE COMMITTED TO PREVENTING AND ENDING HOMELESSNESS FOR MILITARY VETERANS AND THEIR FAMILIES. VET HUNTERS HAS PROVIDED SHELTER, MEALS AND CLOTHES AND JOB TRAINING OPPORTUNITIES FOR HOMELESS VETERANS AND THEIR FAMILIES. STARTED BY THE ASPIRATIONS OF ONE SOLDIER STANDING HERE NEXT TO ME, JOE LEAL, ARMY COMBAT VETERAN FROM THE SOUTH OMANI 155TH COMBAT SUPPORT SUSTAINMENT BATTALION, HE FORMED A COALITION OF PRIOR SERVICE MEMBERS TO PULL HOMELESS VETERANS OUT OF THE SHADOWS AND INTO THE SHELTERS. THE VET HUNTERS TOGETHER AS ONE FAMILY CONTINUE TO FIGHT AND PROVIDE FOR OUR VETERANS WHO HAVE FOUGHT BRAVELY ACROSS THE SEAS FOR THE PRESERVATION OF OUR COUNTRY AND OUR VALUES. GUIDED BY THEIR LOVE FOR THEIR FELLOW SOLDIERS, THE VET HUNTERS HAVE MADE IT THEIR PRIORITY TO OUTREACH TO VETERANS AT ANY LENGTH AT ANY PLACE AT ANY TIME ON ANY DAY. DURING THE HOLIDAYS, I HAD THE PLEASURE OF SERVING MEALS ALONGSIDE THEIR STAFF AND VOLUNTEERS OF VET HUNTERS ON SKID ROW. SEEING VETERANS AND THEIR FAMILIES ENJOY A GOOD MEAL IS HEARTWARMING AND REMINDS THAT OF MORE NEEDS TO BE DONE FOR THE VETERAN COMMUNITY. IT IS GROUPS LIKE THE VET HUNTERS THAT HELP BRIDGE THE GAP BETWEEN GOVERNMENT RESOURCES AND SERVICES TO VETERANS. THE VET HUNTERS HAVE SERVED AS A SECOND FAMILY TO HUNDREDS OF VETERANS IN THE REGION. THEY TRULY PROVIDE A SECOND OPPORTUNITY FOR VETERANS TO RECLAIM THEIR LIVES. THE VET HUNTERS' COMMITMENT TO OUR VETERANS' COMMUNITY HAS TRANSFORMED AND EVEN SAVED MANY LIVES, ONE VETERAN AT A TIME. THEREFORE, ON BEHALF OF THE LOS ANGELES COUNTY BOARD OF SUPERVISORS, IT IS MY HONOR TO PRESENT THE VET HUNTERS THIS CERTIFICATE IN HONOR OF THEIR WORK IN SERVING OUR VETERANS THROUGHOUT LOS ANGELES COUNTY. [APPLAUSE.] 

SUP. KNABE: SUPERVISOR SOLIS, I WOULD JUST LIKE TO ADD. THIS IS AN INCREDIBLE ORGANIZATION. THEY WORK A LOT THROUGHOUT THE ENTIRE COUNTY. BEEN ACTIVE BEHIND LONG BEACH AS WELL AS THROUGH THE SOUTH EAST AREA. ONE VET AT A TIME, THEY'RE A HOME AWAY FROM HOME. SO WE APPRECIATE ALL THAT YOU GUYS DO, THANK YOU. 

SPEAKER: WE HAVE A SAYING AT VET HUNTERS, AND IT'S "NO RED TAPE IS HOW WE OPERATE." I WISH THAT WE DIDN'T HAVE TO ACCEPT THIS. I WISH THAT WE DIDN'T EVEN HAVE TO EXIST. WE ARE VOLUNTEERS, HUSBANDS, DAUGHTERS, WIVES. WE ARE REGULAR PATRIOTS, AMERICANS AND VETERANS GETTING TOGETHER TO SAY THAT THE WORD HOMELESS AND VETERANS SHOULD NEVER GO TOGETHER. WE'RE VOLUNTEERS. WE ARE NONGOVERNMENT-FUNDED. WE ARE SUPPORTED OURSELVES. AND THE REASON WHY IS BECAUSE THESE HEROES DON'T DESERVE TO BE OUT ON THE STREET. SO TO END VETERAN HOMELESSNESS AND TO END THE CITY AND THE COUNTY'S MISSION TO ERADICATE THAT, WE HAVE STEPPED UP. WE HAVE SAID, DO YOU KNOW WHAT? THEY NEED OUR HELP. AND AS CITIZENS AND AGAIN AS VETERANS, WE HAVE STEPPED UP AND SAID WE'RE HERE TO MAKE A DIFFERENCE. WE REALLY APPRECIATE THE ACKNOWLEDGMENT. AND SHE WAS THERE WITH US ON SKID ROW. WE BROUGHT AN IN AND OUT TRUCK ON SKID ROW. WE RAISED THE MONEY OURSELVES. WE FED OUR HOMELESS BROTHERS AND SISTERS IN AND OUT AS A WAY TO TELL THEM WE LOVE THEM BUT IN ADDITION WE PROVIDED SERVICES AND WE BROUGHT HOPE AND HOPE IS A REALLY BIG WORD. SO THANK YOU VERY MUCH. KEEP A LOOKOUT FOR US BECAUSE WE'RE GOING BACK AGAIN THIS SUNDAY AT MACARTHUR PARK AND WE'RE GOING TO GO OUT THERE TO GET THESE WARRIORS OFF THE STREETS. SO THANK YOU. [APPLAUSE.] 

SUP. ANTONOVICH, MAYOR: SUPERVISOR KNABE. 

SUP. KNABE: AT THIS TIME I WOULD LIKE TO CALL BUT GARY JONES, OUR DIRECTOR OF BEACHES AND HARBORS, A DEAR FRIEND TO MANY OF US. MR. JERRY EPSTEIN OF THE SHORES IN MARINA DEL REY. AND WE'RE HERE TO COMMEMORATE THE 50TH ANNIVERSARY OF MARINA DEL REY. IT'S HARD TO BELIEVE IT'S BEEN 50 YEARS, BUT IT HAS. ALSO JOINING US TODAY WE HAVE MANY MEMBERS OF THE COMMUNITY WHO HAVE WORKED SO HARD OVER THE YEARS TO KEEP MARINA DEL REY THAT ULTIMATE DESTINATION NOT ONLY FOR OUR OWN RESIDENTS BUT PEOPLE THROUGHOUT OUR GREAT NATION AND THE WORLD. SO I'D LIKE TO ASK OUR GUESTS OUT HERE FROM MARINA DEL REY, GOOD FRIENDS, TO PLEASE STAND UP AND WE'LL GIVE YOU A LITTLE ROUND OF RECOGNITION THERE. [APPLAUSE]. THIS HAS BEEN A VERY UNIQUE PUBLIC-PRIVATE PARTNERSHIP OVER THE YEARS. AND WHAT WAS ONCE A SALT WATER MARSH MOSTLY KNOWN FOR DUCK HUNTING AND OIL DERRICKS BECAME THE LARGEST MANMADE SMALL CRAFT HARBOR IN NORTH AMERICA WITH THE DEVELOPMENT OF MARINA DEL REY. ON APRIL 10, 1965, MARINA DEL REY WAS FORMALLY DEDICATED. THE YEAR 2015 MARKS THE 50TH BIRTHDAY OF THE CROWN JEWEL OF OUR GREAT COUNTY. MORE THAN FIVE DECADES AGO, A HANDFUL OF CIVIC LEADERS AND INVESTORS HAD A VERY UNIQUE VISION TO CREATE A RECREATIONAL BOATING MARINA. RISKING THEIR PROFESSIONAL CREDIBILITY AND IN THE CASE OF SOME THEIR ENTIRE FORTUNES ON A DAUNTING CONSTRUCTION PROJECT, ONE MADE EVEN MORE DIFFICULT WHEN THE TIDAL SURGE OF A STORMY WINTER OF 1962-63 DESTROYED THE HARBOR. MANY THOUGHT THE OCEAN'S FURY WOULD DEFEAT THE MAN-MADE ENGINEERING MARVEL. BUT THE HARBOR'S FOUNDERS WERE UNDAUNTED, WORKING WITH THE FEDERAL GOVERNMENT AND OTHERS SEEKING AND OBTAINING A SURGE-DEFYING BREAKWATER THAT CLEARED THE WAY FOR THE MARINA TO FLOURISH FOR THE YEARS SINCE. TODAY, THE MARINA IS A STYLISH COASTAL COMMUNITY OFFERING A NUMBER OF DIFFERENT RECREATIONAL BOATING OPPORTUNITIES, WATERFRONT SHOPS, RESTAURANTS, HOTELS AND ABSOLUTELY MARINA DEL REY APTLY NAMED THE HARBOR OF THE KING COMMEMORATES 50 YEARS AS LOS ANGELES COUNTY'S PREMIER DESTINATION FOR WATER-ORIENTED RECREATION AND WISHED ALL THE BEST IN THE CELEBRATION OF THIS GREAT GOLDEN ANNIVERSARY. SO WE WANT TO SAY HAPPY BIRTHDAY, MARINA DEL REY, TO MANY, MANY MORE YEARS. AND AS WE BEGIN THE CELEBRATION FOR THE ENTIRE YEAR, TO WISH THE MARINA A VERY, VERY HAPPY BIRTHDAY. [APPLAUSE.] JERRY AND GARY, WOULD YOU LIKE TO SAY A COUPLE WORDS? 

JERRY EPSTEIN: THANK YOU, SUPERVISOR. IT'S MY GREAT HONOR AND PLEASURE TO REPRESENT ALL OF THOSE WHO HAVE LABORED OVER THESE LAST 50 YEARS TO SERVE AND REALIZE BURTON CHACE'S VISION. BURTON WAS THE SUPERVISOR AT THAT TIME. FOR A VIBRANT URBAN WATERFRONT COMMUNITY AND THE NATION'S LARGEST MANMADE PLEASURE BOAT HARBOR. THE CREATION AND THE DEVELOPMENT AND NOW THE REDEVELOPMENT THANKS TO DON KNABE, THE REDEVELOPMENT, BRINGING US INTO THE 21ST CENTURY, IT'S THE DEDICATION OF THE DEVELOPMENT WITH THE UNIQUE LONG PARTNERSHIP BETWEEN THE BOARD OF SUPERVISORS, THE COUNTY BUREAUCRACY, THE PRIVATE SECTOR AND OUR COMMUNITY. THIS YEAR'S 50TH ANNIVERSARY SHOULD NOT ONLY PAY TRIBUTE TO THE REMARKABLE HISTORY OF THE MARINA, BUT ALSO LAY THE GROUNDWORK FOR THE FUTURE ENJOYMENT OF THE COUNTY'S CROWN JEWEL. WE ARE THE COUNTY'S CROWN JEWEL. THE GENERATION OF COUNTY RESIDENTS AND VISITORS FROM AROUND THE WORLD. I'VE BEEN FORTUNATE TO BE PART OF THE FIRST 50 YEARS. AND OF COURSE I'M THRILLED, REALLY THRILLED TO BE STANDING HERE TODAY AS A STAKEHOLDER COMMITTED TO THE MARINA FOR THE 21ST CENTURY. I'D LIKE TO ASK NOW GARY JONES, DIRECTOR OF THE DEPARTMENT OF BEACHES AND HARBORS, TO DISCUSS OUR FORTHCOMING CELEBRATION. 



SUP. KNABE: THANK YOU AGAIN. HAPPY BIRTHDAY. 

SUP. ANTONOVICH, MAYOR: WELL, MEMBERS, IT'S A PLEASURE TODAY AS LOS ANGELES COUNTY IS RECOGNIZING JANUARY 20, 2015 AS KOREAN-AMERICAN DAY IN OUR COUNTY OF LOS ANGELES. WE'RE VERY PROUD TO COMMEMORATE THE MANY CONTRIBUTIONS AND RECOGNIZE WHAT OUR KOREAN- AMERICANS HAVE DONE IN FURTHER DEVELOPMENT OF OUR COUNTY, OUR STATE AND OUR NATION. FOR MORE THAN A CENTURY, THE KOREAN COMMUNITY HAS REALIZED SIGNIFICANT ACCOMPLISHMENTS IN THE AREAS OF EDUCATION, INDUSTRY, SCIENCE, THE ARTS AND COMMUNITY SERVICE. OUR RELATIONSHIP BETWEEN THE UNITED STATES AND KOREA BEGAN BACK WITH THE TREATY OF FRIENDSHIP AND CONGRESS IN 1882 AND AS A RESULT OF THIS AGREEMENT MANY AMERICANS, ESPECIALLY MISSIONARIES, HAD A ROLE IN THE DEVELOPMENT OF MODERN KOREA. IT WAS ON JANUARY 13, 1903 THAT THE FIRST KOREAN IMMIGRANTS TO THE UNITED STATES ARRIVED IN HONOLULU, HAWAII, ABOARD THE S.S. GAELIC AND BEGAN A NEW LIFE IN THIS COUNTRY. KOREAN-AMERICAN DAY IS A MEANINGFUL EVENT HIGHLIGHTING THE PAST AND PRESENT CONTRIBUTIONS OF KOREAN- AMERICANS TO OUR SOCIETY. AND AS PART OF THAT AMERICAN CULTURAL TRAVESTY OUR CITIZENS OF KOREAN ANCESTRY SHARE FREEDOM AND PEACE BASED ON A COMMON RESPECT FOR HUMAN DIGNITY, PROSPERITY, RELIGIOUS FREEDOM AND DEMOCRACY. FROM THE KOREAN- AMERICAN FOUNDATION TODAY WE HAVE THE NATIONAL PRESIDENT SUN PARK, PRESIDENT SUN KIM, PRESIDENT TAN CHUNG, CHAIRMAN TAN CHUNG AND SENIOR ADVISOR DR. YOUNG JAN KIM. SO LET ME GIVE THIS TO THE KOREAN AMERICAN DAY. AND THEN THE KOREAN IMMIGRATION. LET'S DO PICTURES AND YOU CAN ALL SAY SOMETHING. YOU CAN ALL SAY A FEW WORDS. PAUL HERE SERVED WITH PRESIDENT BUSH AS HEAD OF THE PEACE CORPS IN THE BUSH ADMINISTRATION AND ALSO WAS QUITE INVOLVED AND WAS ONE OF OUR GREAT REPUBLICAN CANDIDATES FOR THE STATE LEGISLATURE MANY, MANY YEARS AGO, WAS IT IN THE 1990S? ANYWAY, PAUL AND HIS WIFE HAVE BEEN INVOLVED IN OUR COMMUNITY AND NOW AS A SPECIAL ASSIGNMENT WITH THE UNITED NATIONS WHERE THEY'RE TAKING COMPUTERS, RETROFITTING THOSE COMPUTERS FOR THE CHILDREN, DISADVANTAGED CHILDREN THROUGHOUT THE WORLD. THE SECRETARY GENERAL OF THE UNITED NATIONS IS HIS CLASSMATE. 

SPEAKER: MIKE YOU KNEW MORE ABOUT IT THAN I THOUGHT YOU KNEW ABOUT IT. MIKE, PERSONALLY IT IS SO GREAT TO SEE YOU. I ENJOY RECEIVING YOUR EMAIL EVERY DAY, SOMETIMES TWO OR SOMETIMES FIVE. JUST WHILE AGO, I RECEIVE ABOUT MASS, YOU HAD SOMEBODY HAD AT -- SO I WANT YOU TO KNOW I READ THAT SOMETIMES. AND I ENJOY LOOKING AT YOUR CHILDREN. THEY ARE GROWING UP REAL GOOD. SO TODAY I'M VERY HONORED TO INTRODUCE TO YOU HONORABLE YOUNG JIM KIM. HE SERVED FIVE TERMS IN THE KOREAN NATIONAL ASSEMBLY. BUT HE'S SO GOOD, KOREAN AMERICAN FOUNDATION INVITE HIM TO BE THE SENIOR ADVISER TO THEIR FOUNDATION. SO THAT'S WHY HE'S HERE TO EXPRESS APPRECIATION ON BEHALF OF THE FOUNDATION. 

SPEAKER: MR. ANTONOVICH, SUPERVISOR, [SPEAKING KOREAN] MAYOR MIKE ANTONOVICH AND THE SUPERVISORS, ON BEHALF OF THE KOREAN-AMERICANS ALL OVER THE COUNTRY, ESPECIALLY KOREAN- AMERICANS IN LOS ANGELES COUNTY, ABOUT 500,000, WE WANT TO THANK YOU FOR HONORING US WITH THIS PROCLAMATION, HONORING THE KOREAN-AMERICAN CONTRIBUTION AND LIVING IN THE UNITED STATES OF AMERICA. [SPEAKING KOREAN]. FOR 11TH YEAR, YOU HAVE PROCLAIMED KOREAN-AMERICAN DAY. FOR THIS, WE ARE DEEPLY GRATEFUL FROM THE BOTTOM OF OUR HEARTS. [SPEAKING KOREAN] THIS IS THE SECOND TIME I'M ATTENDING YOUR SUPERVISORS MEETING. [SPEAKING KOREAN] YOU MAY LIKE TO KNOW, IT MAY SOUND STRANGE, BUT YESTERDAY I ATTENDED THE 16TH TIME MARTIN LUTHER KING PARADE. AND ONE TIME I SERVED AS GRAND MARSHAL AND MANY TIMES I SPOKE AT THE EVENT AND BEEN ON THE OPEN CAR PARADE. [SPEAKING KOREAN] I WANT YOU TO KNOW, EVEN IN KOREA WE CELEBRATE MARTIN LUTHER KING DAY BECAUSE HIS COURAGE TO FIGHT FOR THE CIVIL RIGHTS OF NOT ONLY AFRICAN-AMERICANS BUT ALL AMERICANS AND ALL THE PEOPLE AROUND THE WORLD. SO HE'S LIVING WITH US. HIS SPEECH UNDER "I HAVE A DREAM" IS IN THE HEARTS OF MANY, MANY YOUNG PEOPLE IN KOREA AS WELL AS IN AMERICA. [SPEAKING KOREAN] ONCE AGAIN, I LIKE TO THANK MAYOR ANTONOVICH AND THE SUPERVISORS FOR GIVING US THIS OPPORTUNITY. FOR MY PERSONAL NOTE, I WANT YOU TO KNOW THAT 500,000 KOREAN- AMERICANS IN LOS ANGELES COUNTY ARE GRATEFUL FOR YOUR DEDICATED SERVICE ON BEHALF OF ALL OF US. AND WE ENJOY LIVING IN THE GREAT COUNTY OF LOS ANGELES. GREATEST COUNTY IN OUR COUNTRY. THANK YOU. THANK YOU VERY MUCH. [APPLAUSE.] THIS WILL BE ON THE FRONT PAGE OF KOREAN-AMERICAN NEWSPAPER ALL OVER THE WORLD. 

SPEAKER: LET ME GIVE THE SPECIAL MESSAGE FROM WHITE HOUSE FOR THE RECORD. LET ME READ FROM THE PRESIDENT BARACK OBAMA FROM UNITED STATES OF AMERICA. THE WHITE HOUSE, WASHINGTON, JANUARY 12, 2015. "I SEND GREETINGS TO ALL THOSE OBSERVING KOREAN-AMERICAN DAY. THE DIVERSITY OF OUR PEOPLE HAS ALWAYS BEEN ESSENTIAL TO AMERICA'S PROGRESS AND ECONOMIC SUCCESS. AND GENERATIONS OF KOREAN- AMERICANS HAVE BEEN INTEGRAL TO THIS GROWTH. FOR OVER A CENTURY, KOREAN- AMERICANS HAVE HELPED BUILD, DEFEND AND FORTIFY OUR COUNTRY, DEMONSTRATING WE ARE STRONGEST AS A NATION WHEN WE HARNESS THE TALENTS OF ALL OUR PEOPLE. ON THIS SPECIAL OCCASION, WE RECOGNIZE THE ENDURING ALLIANCE AND FRIENDSHIP BETWEEN THE UNITED STATES AND THE REPUBLIC OF KOREA. OUR TWO PEOPLES HAVE WALKED ALONGSIDE EACH OTHER WITH A COMMON COMMITMENT AND SHARED SACRIFICE FOR MORE THAN 60 YEARS. UPHOLDING REGIONAL PEACE AND SECURITY AND PROMOTING DEMOCRATIC VALUES ACROSS THE GLOBE. AS YOU CELEBRATE THE WAYS KOREAN- AMERICANS HAVE ENRICHED OUR NATIONAL CHARACTER, I WISH YOU ALL THE BEST. THE PRESIDENT OF THE UNITED STATES OF AMERICA, BARACK OBAMA." THANK YOU. [APPLAUSE.] 

SUP. ANTONOVICH, MAYOR: NOW WE HAVE A LITTLE 24 WEEK OLD TERRIER. YORKIE TERRIER. LITTLE SASSY. SHE'S COMING WITH A LITTLE RED JACKET. SHE'S LOOKING FOR A HOME. ANYBODY LIKE TO ADOPT LITTLE SASSY? CALLED 562-256-1649. AND LITTLE SASSY IS LOOKING FOR A LITTLE LOVE AND A LITTLE HOME. WILL PROVIDE A LOT OF COMFORT, FRIENDSHIP, COMPANIONSHIP TO YOU. SHE'S A VERY SWEET LITTLE GIRL. VERY SWEET. DR. GENEVIEVE CLAVREUL, ITEM 3, 6, 12, 14. HERMAN HERMAN 20, 23, 42-A, CS-1. ERIC PREVEN, 3, 8, 12, 20, 27, 28, 42-A. AND MR. SACHS, 1-D, 11, 20, 23, 37, 39. MR. PREVEN? 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: MR. MAYOR, BEFORE WE GO, IF I COULD, IF WE COULD CLARIFY ON ITEM 38, THE INTERIM C.E.O., CHIEF EXECUTIVE OFFICER, REQUESTS THAT THIS ITEM BE REFERRED BACK TO THE DEPARTMENT RATHER THAN BEING CONTINUED. 

SUP. ANTONOVICH, MAYOR: SO MOVED, SECONDED BY MARK RIDLEY-THOMAS, WITHOUT OBJECTION SO ORDERED. 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: THANK YOU. 

SUP. ANTONOVICH, MAYOR: MR. PREVEN? 

ERIC PREVEN: IT IS ERIC PREVEN, COUNTY RESIDENT FROM DISTRICT 3 AND ALSO CANDIDATE FOR THE CITY COUNCIL IN DISTRICT 2 -- CITY COUNCIL DISTRICT 2. THIS IS QUITE AN INTERESTING AGENDA. ON ITEM NO. 3, I WOULD LIKE TO THANK MARK RIDLEY-THOMAS FOR REACHING IN THE DIRECTION OF OPEN DATA FROM OUR OPEN GOVERNMENT CHAMPION, I DO APPRECIATE THAT. ITEM NO. 12 IS RELATED. IT'S A TERRA NOVA CONSULTING CONTRACT TO TRAIN INDIVIDUALS IN SECURITY AND PRIVACY TRAINING. AND I WOULD JUST ASK THAT SOME OF THE SHARPER ATTORNEY TYPES LOOK CLOSELY AT WHAT SPECIFIC TRAINING WE WILL BE PROVIDING, BECAUSE THIS IS AN AREA WHERE WE WANT TO MAKE SURE THAT WE DON'T FIND WAYS TO PREVENT DISCLOSURES OF THINGS AS A WAY OF PROTECTING PRIVACY. WE ABSOLUTELY VALUE PRIVACY AND PROTECTION OF INDIVIDUALS, FOR EXAMPLE, SOCIAL SECURITY NUMBERS, BUT WE WANT FULL ACCESS TO PUBLIC DATA. ITEM NO. 27 AND 28 IS CONTRACTS WITH SECURITAS USA. SECURITAS, FOR THOSE THAT DON'T KNOW, A LARGE, SWEDISH, VERY NICELY MANAGED SECURITY COMPANY. WE HAVE A LOT OF CONTRACTS WITH THEM. THESE TWO ITEMS INVOLVE SAYING GOODBYE TO NORTH AMERICAN SECURITY, WHO ALWAYS HAD THE SORT OF SMALLER BIT OF CONTRACTS, AND ALLOWING SECURITAS TO BULK UP. THIS BULKING UP REQUIRES CAREFUL CONSIDERATION OF THE BOARD IN THE CONTEXT OF THE ONGOING PRIVATIZATION OF PUBLIC SERVICES. I THINK IT'S WORTH A CLOSE LOOK. I HAVE NOTHING NEGATIVE TO SAY ABOUT SECURITAS EXCEPT FOR ONE THING, THAT THEY CAME BEFORE THIS BOARD CRYING FOUL BECAUSE THEY LOST A CONTRACT TO NORTH AMERICAN SOME YEARS AGO, AND THEN THE ISSUE THAT CAME OUT IS THEY WERE UPSET THAT THERE WAS GOING TO BE AFFORDABLE CARE ACT COSTS THAT WOULD BUMP THEIR CONTRACTS UP. AND THEY WERE RESISTING THAT. AND WE SHOULD JUST WATCH THAT VERY CLOSELY. ITEM NO. 20, I TRIED TO GET SOME CLARITY. IT'S AN ENGINEERING CONSULT BETWEEN THREE SEPARATE FIRMS THAT ARE ON A PANEL. SUPERVISORS, I KNOW YOU HAVEN'T HEARD SOME OF THESE THINGS. A.E.C.O.M. IS A BIG COMPANY THAT HAS BEEN CONSULTING FOR US IN LOTS OF AREAS INCLUDING OUR JAIL PLAN AND HERE IS AN OPPORTUNITY FOR UNSPECIFIED 5 MILLION, 5 MILLION, 5 MILLION TO BE AWARDED TO, AMONG OTHERS, A.E.C.O.M. AND THE QUESTION IS: FOR WHAT PROJECTS? BECAUSE I DO THINK IT'S CRITICALLY IMPORTANT THAT IT BE COMING BACK HERE. I UNDERSTAND THIS IS TO ACCOMMODATE CERTAIN FEDERAL GUIDELINES FOR FUNDING ON CERTAIN PROJECTS, BUT I STILL THINK THAT THAT'S WORTH A CAREFUL LOOK. ITEM NO. 29 I HAVE A SIMPLE QUESTION. WHY SHOULD IT BE SOLE SOURCE? I HAVE NO OBJECTION TO MUGSHOT TECHNOLOGY, BUT WHY IN THE WORLD SHOULD IT BE SOLE SOURCE? THERE'S COMPETITION OUT THERE. AND ITEM NO. I BELIEVE IT IS ITEM NO. 18, NO, SORRY, IT IS NOT ITEM NO. 18. IT IS ITEM NO. 19, WE HAVE A 50,000 SQUARE FOOT FACILITY GOING UP AT THE MARTIN LUTHER KING, JR. CAMPUS. IT'S NOT YET DONE BUT THERE'S GOING TO BE SOME BIDS ON THAT, I GUESS. AND IT'S GOING OUT TO A VERY SHORT LIST. I WAS CURIOUS. HOW WAS THAT SHORT LIST CREATED? AND THAT CONCLUDES MY COMMENTS FOR TODAY. THANK YOU. 

SUP. ANTONOVICH, MAYOR: THANK YOU. DR. CLAVREUL? 

DR. GENEVIEVE CLAVREUL: YEAH, GOOD AFTERNOON, BOARD OF SUPERVISORS. DR. GENEVIEVE CLAVREUL. ON ITEM 6 IN PARTICULAR, WE ARE TALKING AGAIN ABOUT FOR TRAUMA TO HAVE CERTAIN HOSPITAL DESIGNS, HUNTINGTON AND U.S.C. MEDICAL CENTER. I DON'T KNOW ABOUT YOU, BUT I READ RECENTLY THE GRADE OF THE HOSPITAL. AND FOR U.S.C. MEDICAL CENTER, WE WENT FROM A "B" TO A "C" TO A "D" AND ALL UNDER DR. KATZ, THE WONDERFUL _____ THAT YOU LIKE SO MUCH. DR. KATZ TOOK POWER HIS JOB IN 2011. FROM 2011 TO NOW WE WENT FROM LIKE I SAID FROM AN "A" TO A "D". AND RIGHT NOW HE'S TRYING TO BE IN CHARGE OF THREE DEPARTMENTS. I URGE YOU NOT TO MERGE THOSE THREE DEPARTMENTS. HE CANNOT EVEN HANDLE U.S.C. AND U.S.C. WE WENT FROM A TOP OF THE LINE HOSPITAL TO A GRADE OF A "D". THAT'S PRETTY SCARY TO ME. AND I REALLY WOULD LIKE FOR YOU TO LOOK A LITTLE MORE IN DETAIL OF THAT, ESPECIALLY IT'S ONE OF THE BEST TRAUMA CENTERS WE HAVE IN THE COUNTY. SO I'M NOT PLEASED AT ALL ABOUT WHAT'S GOING ON. AND I ALSO WOULD LIKE TO HAVE A COPY OF THE CORRESPONDENCE BETWEEN DR. KATZ AND THE BOARD OF SUPERVISORS. IT MAY MEAN THAT YOU HAVE REFUSED TO PROVIDE TO L.A. TIMES OR TO ANY PUBLIC. PERSONALLY TO ME IT SOUND LIKE SERIAL MEETING, BUT PLEASE GIVE ME A COPY OF THAT MEMO. I'D BE GLAD TO REVIEW IT AND SEE FOR MY OWN EYES WHAT'S GOING ON BETWEEN THAT MERGER OF THOSE THREE UNITS. ON INFORMATION TECHNOLOGY, I MEAN THAT'S THE SAME ITEM WE HAD A LONG TIME AGO. AND WE ARE DOING THE SAME THING OVER AGAIN. AND ACTUALLY MANY OF THE ITEMS I WANTED TO TALK TODAY WERE CONTINUED. 15, 19 AND 29. AGAIN VIOLATING THE BROWN ACT. ACTUALLY IT'S POSTED ON THE AGENDA, SO PUBLIC HAS A RIGHT TO SPEAK TO THOSE ITEMS. AND YOU HAVE DONE THAT RECENTLY FOR THE LAST FEW MONTHS. IT'S TOTALLY INAPPROPRIATE. AND I'M SEEING LESS AND LESS TRANSPARENCY. AND THIS IS NOT GOOD. SO I WOULD REALLY URGE YOU TO STOP THAT HABIT, TO PUT ITEMS ON YOUR AGENDA AND AT THE LAST MINUTE CHANGE YOUR MIND. THANK YOU FOR YOUR ATTENTION. HAVE A GOOD DAY. 

SUP. ANTONOVICH, MAYOR: THANK YOU, DOCTOR. MR. SACHS? 

ARNOLD SACHS: YES, THANK YOU, GOOD MORNING -- OR GOOD AFTERNOON, ARNOLD SACHS. I DID HOLD SEVERAL ITEMS. YOU KNOW ONE OF MY FAVORITES IS SOUND INSULATION AND THE USE OF AIRPORT FUNDS. IT STATES HERE THEY ARE GOING TO APPROXIMATELY JUST UNDER $1.3 MILLION. NOW, SOME OF THOSE FUNDS ARE COLLECTED FROM PASSENGERS WHO USE CABS. THEY PAY A FEE, AIRPORT FEE OF $4, I BELIEVE. BUT ACCORDING TO ONE OF THE MANAGERS OR OWNERS OF ONE OF CAB COMPANIES, THE CAB COMPANIES ACTUALLY RECEIVE $2 OF THAT $4 THAT IS COLLECTED BY THE CAB DRIVERS. SO INSTEAD OF 325,000 TRIPS TO COVER THAT $1.3 MILLION, IT TAKES 650,000 TRIPS TO COVER THAT $1.3 MILLION. THAT'S QUITE A DIFFERENCE. ESPECIALLY WITH THE AIRPORT. YOU KNOW, THAT'S A LOT OF MONEY. CONSIDERING THAT THE COUNTY'S BUDGET IS HALF A BILLION DOLLARS A WEEK. AND THE L.A.X. SPENT $250 MILLION ON A GENERAL PLAN, AND THERE'S NO SUBWAY AND THERE'S NO TRANSPORTATION, PUBLIC TRANSPORTATION TO THE AIRPORT, YOU WOULD THINK THAT THAT $2 WOULD COME IN HANDY FOR PUBLIC TRANSPORTATION, BUT IT DOESN'T. I HELD ITEMS 11 AND 37, YOU KNOW IT SAYS ON ITEM NO. 11, AGAIN IT'S ORDINANCE POSITIONS, AND IMPLEMENT THE RESULTS OF AMBULATORY CARE STUDY. AND THEN IT SAYS RELATES TO ITEM 37. WELL ITEM 37 DOESN'T RELATE -- DOESN'T MENTION ANYTHING ABOUT THE CARE STUDY AT ALL. SO HOW CAN THAT BE ADOPTED IF IT'S AN ORDINANCE AND IT RELATES TO ITEM 37? I HELD ITEM NO. 20. IT'S $5 MILLION CONTRACTS. THREE OF THEM. SO WHERE'S THE VET HIRING PART OF THAT CONTRACT? DON'T YOU HAVE A VET PROGRAM WHERE CONTRACTS OVER $5 MILLION SHOULD INCLUDE VETS? OH, WAIT, THAT'S ONLY CONSTRUCTION. SO ARE YOU SAYING THAT VETS ARE UNCAPABLE OF DOING THESE OTHER OPERATIONS, THIS TECHNICAL TRAINING? I FIND THAT AWFULLY HARD TO BELIEVE. I WISH ONE OF THE SUPERVISORS WOULD STEP UP AND SAY THAT SHOULD BE INCLUDED IN ALL THE CONTRACTS WE GIVE OUT BECAUSE WE'RE DOING SO MUCH TO HIRE VETS. I HELD ITEM 23. IT'S ABOUT THE FOURTH INSTALLMENT OF PROPOSITION 1-P FUNDS. AND THEN I PICKED UP THIS REPORT. IT MENTIONS THAT THE COUNTY HAS RECEIVED ITS ENTIRE SHARE OF THE $190 MILLION AFTER CONSIDERATION OF THE STATE'S ADMINISTRATIVE FEE. AND I REMEMBER THAT YOU HAD AN ITEM ON YOUR AGENDA LAST YEAR FOR STATE ADMINISTRATIVE FEE, 20 PERCENT. $1 MILLION ALLOCATED TO THE COUNTY, THE STATE'S GETTING 20 PERCENT ADMINISTRATIVE FEE. DO YOU THINK THAT'S ALLOWED, MISS KUEHL? YOU WERE IN STATE LEGISLATION. DO YOU THINK 20 PERCENT OF 1 BILLION FOR ADMINISTRATION, THAT'S $200 MILLION. THAT'S NOT BAD IF YOU CAN GET AWAY WITH IT. 

SUP. ANTONOVICH, MAYOR: THANK YOU. MR. HERMAN HERMAN? 

HERMAN HERMAN: MAYBE I CAN SPEAK ABOUT WHAT MR. ARNOLD SACHS IS TALKING ABOUT ON ITEM 23. WELL, THANK YOU FOR TELLING ME TO SHUT UP, MR. ARNOLD, VERY PROFESSIONAL OF YOU. BUT YOU COME IN WITH JUST THAT, YOU DON'T COME IN WITH THE FACTS, ARNOLD. CONSTANTLY PICKING ON MISS SHEILA HERE INSTEAD OF GIVING HER THE OPPORTUNITY TO MAYBE ALLOW THIS TO HAPPEN. BUT THE RECOMMENDATIONS TO APPROVE THE DEPARTMENT OF PUBLIC WORKS REVISED LISTS OF ROAD IMPROVEMENTS, I FIND IT TIMELY AND MANAGEABLE NOW THAT THE FEDERAL TRANSIT ADMINISTRATION HAS COME FORWARD TO THE CITY OF LOS ANGELES, ALONG WITH THE COUNTY, QUESTIONING WHY CERTAIN STREETS IN OUR COMMUNITIES HAVE NOT BEEN REPAIRED, ALTERED OR FIXED DUE TO THE EXTENT THAT WE'RE LOOKING AT TRAFFIC SAFETY HERE. THE INFRASTRUCTURE THROUGHOUT THE COUNTY HAS ALWAYS BEEN A TROUBLING PROBLEM FINANCIALLY. WHETHER OR NOT THE COUNTY IS UTILIZING THE FEDERAL STATE DOLLARS THAT ARE MANDATED TO RELIEVE THE PROBLEM OF OUR TRAFFIC SAFETY, PEDESTRIAN SAFETY, I FIND IT INCONCLUSIVE. SO IN REGARDS TO THE FUTURE IMPROVEMENTS, AND AS MANY OF YOU ARE ALL AWARE THAT WE LOST -- UNFORTUNATELY WE LOST THE CONDITIONS FOR THE OLYMPICS HERE. LIKELY THE CAUSE AND EFFECT OF THAT WERE SIMPLY THAT THE SAFETY OF YOUR PEDESTRIANS, YOUR CONSTITUENTS AND ALL THOSE HERE TO TOUR FOR THE EVENTS FEEL THAT THEIR HEALTH AND SAFETY IS BASICALLY IN TROUBLE. I FIND IT THAT WAY. I TRIP AND SLIP CONSTANTLY ON THE POOR IMPROVEMENTS OF SIDEWALKS AND THE POTHOLES THROUGHOUT THE CITY OF LOS ANGELES. I JUST MIGHT AS WELL TIE IT IN WITH WHAT JOHN WALSH POINTED OUT OVER AND OVER, HOLLYWOODHIGHLAND.ORG, WE HAVE BECOME THE POTHOLE CAPITAL OF THE WORLD SIMPLY BECAUSE WE DON'T WANT TO UTILIZE THE BUDGETARY BUDGET THAT WE THE TAXPAYERS ARE PAYING ON FOR ALL THESE YEARS TO SEE THE IMPROVEMENT OF INFRASTRUCTURE. THE INFRASTRUCTURE THROUGHOUT THE COUNTY OF LOS ANGELES IS HORRIBLE. IT'S VERY BAD. AND HOPEFULLY WE DO NOT BECOME THE NEXT CITY COUNTY AND COUNTY AND COUNTY OF LOS ANGELES TO HAVE A PROBLEM WITH SLIPS AND FALLS ANYMORE BECAUSE I'M SURE THAT WITH ALL THIS MONEY THAT IS BROUGHT UP BY ARNOLD, THAT 20 PERCENT WILL RELATE TO THE CONSTITUENTS OF YOUR COMMUNITIES. THANK YOU. 

SUP. ANTONOVICH, MAYOR: OKAY. BUT DON'T CONFUSE LOS ANGELES CITY WITH LOS ANGELES COUNTY. IT'S A LITTLE BETTER ROAD IMPROVEMENTS AND MANY OF THE OTHER 87 CITIES, AS WELL, HAVE DONE A BETTER JOB ON THEIR ROADS. SO DON'T MIX UP L.A. CITY WITH ALL THE OTHER CITIES WITHIN THE COUNTY OR THE COUNTY. THAT WAS A SEPARATE ISSUE THAT WAS BEING ADDRESSED TO THE CITY OF LOS ANGELES. 

HERMAN HERMAN: WELL I LIVE IN THE FIRST DISTRICT, SIR, THANK YOU. 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: MR. MAYOR, THERE ARE A NUMBER OF ITEMS BEFORE YOU. ITEM 1-D, 3, 8, 11, 12, 14, 20, 23, 27, 28, 37, 39 AND 42-A. 

SUP. ANTONOVICH, MAYOR: OKAY. MOTION BY SUPERVISOR KUEHL. SECONDED WITHOUT OBJECTION, SO ORDERED. LET ME TAKE ITEM 6, BECAUSE WE DID HAVE SPEAKERS MENTIONED ON THAT. SUPERVISOR SOLIS, YOU HAD HELD THAT MOTION. 

SUP. SOLIS: THANK YOU, MR. MAYOR. I WANT TO THANK YOU AND COMMEND YOU FOR YOUR LEADERSHIP. I KNOW LAST YEAR, YOU HAD INTRODUCED A COUNTY RESOLUTION TO REQUEST A THOROUGH REVIEW OF OUR TRAUMA CENTER SYSTEM IN THE SAN SAN GABRIEL VALLEY. I KNOW THAT WAS ONE OF THE FIRST ITEMS WE TALKED ABOUT WHEN I CAME TO THE BOARD. SOME OF YOU MAY NOT KNOW THIS, BUT BACK IN 1983, WHEN LOS ANGELES FIRST DESIGNED AND IMPLEMENTED ITS TRAUMA CARE SYSTEM, IT WAS WIDELY RECOGNIZED THAT ACCESSIBLE HOSPITAL TRAUMA SERVICES FOR VICTIMS OF CATASTROPHIC AUTOMOBILE ACCIDENTS, GUNSHOT WOUNDS AND OTHER INJURIES COULD BE THE DIFFERENCE BETWEEN LIFE AND DEATH. FOR SO MANY PATIENTS IN THE EAST SAN GABRIEL VALLEY TODAY SINCE 1987 WHEN TWO TRAUMA CENTER CARE HOSPITALS WITHDREW FROM THAT SYSTEM, THE ACCESS TO QUALITY TRAUMA CARE WAS DELAYED. IN THE CRITICAL MOMENTS AFTER SEVERE INJURY, THEY HAVE TO BE TRANSPORTED TO L.A. U.S.C. MEDICAL CENTER OR HUNTINGTON MEMORIAL MEDICAL CENTER BY EITHER GROUND OR HELICOPTER. IN THE BEST-CASE SCENARIO, WITHOUT TRAFFIC, IT CAN TAKE UP TO 30 MINUTES. AND AS YOU KNOW, THOSE MINUTES AND SECONDS MEAN SOMEONE'S LIFE OR DEATH. IT IS IMPERATIVE FOR THE MORE THAN 1,100 PATIENTS WHO NEED TRAUMA CARE SERVICES ANNUALLY IN THAT SIGNIFICANT REGION, THAT WE MOVE QUICKLY TO SELECT AN APPROPRIATE FACILITY IN RESPONSE TO THE COUNTY'S AUGUST 2014 REQUEST MADE BY OUR MAYOR. LET'S MOVE FORWARD TO PROVIDE THE RESIDENTS OF A VAST AREA EAST OF THE 605 FREEWAY WITH TRAUMA CARE THAT IS SAFE, ACCESSIBLE AND, INDEED, VERY MUCH NEEDED BY PATIENTS. THANK YOU VERY MUCH, MAYOR. 

SUP. ANTONOVICH, MAYOR: MOTION BY SOLIS. SECONDED, SUPERVISOR MARK RIDLEY-THOMAS? 

SUP. RIDLEY-THOMAS: MR. MAYOR, MAY I COMMEND BOTH SUPERVISOR SOLIS AND YOURSELF ON THE MATTER OF TRAUMA CARE IS CRITICALLY IMPORTANT TO ALL OF US, AN ISSUE THAT I'M HAPPY TO OBLIGE TO SUPPORT THIS MOTION. AND URGE D.H.S. TO CONTINUE TO DO THE GOOD WORK IT'S DOING, PARTICULARLY AS IT RELATES TO THE IMPACT OF THE AFFORDABLE CARE ACT. IT WOULD SEEM TO ME THAT D.H.S. HAS AN OPPORTUNITY TO LOOK AT THE ADEQUACY OF TRAUMA CARE COUNTY-WIDE. CERTAINLY THE MOTION THAT WAS INTRODUCED SOME MONTHS AGO AND THE REPORT THAT HAS BEEN ISSUED RELATING TO THE SOUTHEAST PORTION OF OUR COUNTY, SPECIFICALLY THE M.L.K. PHASE 2 EFFORT IS IMPORTANT. AND WHY IS THAT IMPORTANT? IT'S IMPORTANT BECAUSE OF THE PENDING SALE OF THE DAUGHTERS OF CHARITY SYSTEM AND ST. FRANCIS MEDICAL CENTER IN PARTICULAR TO A FOR-PROFIT ENTITY THAT HAS CAUSED A NUMBER OF US SIGNIFICANT CONCERN. ST. FRANCIS, AS YOU KNOW, PLAYS A CENTRAL AND PIVOTAL ROLE IN THE PROVISION OF TRAUMA CARE TO THE SOUTH LOS ANGELES COMMUNITY, PARTICULARLY THE SOUTHEASTERN PORTION OF LOS ANGELES AND SURROUNDING COMMUNITIES. FOR THAT REASON, WE ARE DRAFTING A LETTER TO THE ATTORNEY GENERAL URGING THAT SHE CONDITION THE SALE OF ST. FRANCIS ON A REQUIREMENT THAT THE NEW OWNER CONTINUE TO PROVIDE QUALITY TRAUMA CARE AND EMERGENCY SERVICES. IF THAT DOES NOT HAPPEN, LET ME JUST SIMPLY MAKE IT CLEAR, IT WILL ADVERSELY AFFECT THE FORWARD MOVEMENT THAT WE'RE MAKING WITH THE BUILDING OF THE M.L.K. CAMPUS AND WE DO NOT WISH TO SEE THAT HAPPEN. EVERYBODY HAS TO CARRY THEIR OWN WEIGHT. SO ANY SALES THAT SHRINK, DENY AND THE LIKE APPROPRIATELY GET OUR ATTENTION, SO WE ARE ON THE CASE HERE. THIS IS NOT A NEW ISSUE FOR THIS BOARD. WE'VE RAISED THIS BEFORE, ALL FIVE MEMBERS, SIGNED ONTO THE LETTER AT THE TIME PRIOR TO THE NAMED ENTITY IN TERMS OF THE TRANSACTION. AND AS WE TALK ABOUT TRAUMA CARE, I WANT TO ONCE AGAIN INDICATE MY SUPPORT FOR THIS MOTION, BUT TO SAY AT THE SAME TIME, WE THINK ABOUT TRAUMA CARE, WE OBVIOUSLY HAVE TO THINK COUNTY-WIDE BECAUSE IF WE DO NOT, THOSE HOSPITALS THAT LOSE TRAUMA CARE, EMERGENCY SERVICES WILL ADVERSELY AFFECT THE REMAINING HOSPITALS, THEREFORE WEAKENING THE SAFETY NET. WE WANT TO STRENGTHEN THE SAFETY NET AS THIS MOTION SEEKS TO DO. I'M PLEASED TO SUPPORT IT. 

SUP. ANTONOVICH, MAYOR: OKAY. WITHOUT OBJECTION -- SUPERVISOR DON KNABE? 

SUP. KNABE: YEAH, I WANT TO CHIME IN HERE BECAUSE OBVIOUSLY THE WHOLE SOUTHEAST PORTION OF MY DISTRICT IS DRAMATICALLY AFFECTED BY ALL OF THIS. AND I ALSO HAVE THE CONCERNS OF THE QUICK OVERLOAD EITHER AT M.L.K. OR DOWNEY, SOME OF THE OTHERS SHOULD THIS DAUGHTERS OF CHARITY DEAL GO THE WRONG WAY ON US AS WELL, TOO. SO GLAD WE'RE PUTTING THE LETTER TOGETHER AND FORWARD IT TO THE ATTORNEY GENERAL BUT THIS IS REALLY IMPORTANT. IT ALWAYS HAS BEEN. IT'S BEEN A LONG TIME. WE'VE HAD A COUPLE OPPORTUNITIES COME AND GO AS IT RELATES TO BUILDING A MEDICAL FACILITY OUT THERE ON A PUBLIC-PRIVATE PARTNERSHIP, BUT THEN MONEY CYCLES TURNED AGAINST US. BUT IT'S REALLY IMPORTANT THAT WE GET THE TRAUMA CARE OUT THERE. AGAIN, I STRONGLY SUPPORT THE MOTION AS WELL TOO. 

SUP ANTONOVICH, MAYOR: WITHOUT OBJECTION, SO ORDERED. OKAY. WE HAVE A SET ITEM. S-1. O.I.G. AND SHERIFF? GOOD MORNING. GOOD MORNING. 

SHERIFF JIM MDDONNELL: GOOD AFTERNOON. 

SUP. ANTONOVICH, MAYOR: NOW, IT'S AFTERNOON. 

SHERIFF JIM MDDONNELL: YEAH, YEAH, THANK YOU. 

SUP. ANTONOVICH, MAYOR: DO YOU WANT TO OPEN. 

SHERIFF JIM MDDONNELL: SURE, IT WOULD BE GREAT. FIRST TIME IN MY CAPACITY AS SHERIFF APPEARING BEFORE THE BOARD TO DISCUSS THE C.C.J.V. IMPLEMENTATION. LET ME BE CLEAR THAT NO AREAS OF HIGHER PRIORITY TO ME THAN CONTINUED PROGRESS IN REGARD TO HOW WE TREAT AND TEND TO THE NEEDS OF AND HOUSE THOSE ENTRUSTED TO OUR CARE IN OUR JAIL FACILITIES. AS THE BOARD KNOWS, I AM NO STRANGER TO THESE ISSUES. I WAS PROUD TO SERVE ON THE C.C.J.V. AND HAD AN OPPORTUNITY TO CREATE A ROADMAP AND DETAILED BLUEPRINT FOR CHANGE IN THE CUSTODY DIVISION. WITH THE LEADERSHIP OF ASSISTANT SHERIFF MCDONALD AND THIS BOARD AND THE COMMITMENT OF THOSE WITHIN L.A.S.D. AS WELL AS THE IMPLEMENTATION MONITOR WE CAME A LONG WAY SINCE THE C.C.J.V. REPORT ISSUED. INDIVIDUALS WHO SERVED AS EXPERTS ADVISING OUR COMMISSION AND WHO DESCRIBED IN THE 2012 JAIL SYSTEM WITH TREMENDOUS CONCERN HAVE SINCE OPINED THAT OUR JAILS ARE A VERY DIFFERENT PLACE TODAY THAN THEY WERE THEN. WHILE THAT BY NO MEANS SHOULD SUGGEST THAT OUR WORK IS FINISHED AND I BY NO MEANS BELIEVE THAT PAST PROBLEMS HAVE BEEN FULLY FIXED, WE CAN BE PROUD OF HOW FAR WE'VE COME SINCE THE C.C.J.V. REPORT ISSUED. HUGE PROGRESS HAS BEEN MADE IN A VARIETY OF AREAS SINCE THE C.C.J.V. REPORT ISSUED IN THE FALL OF 2012. AND I'LL JUST BRIEFLY TOUCH ON SOME OF THOSE. THE HIRING OF A PROFESSIONAL HEAD FOR CUSTODY, ASSISTANT SHERIFF MCDONALD. A TRUE CORRECTIONS EXPERT THAT WE'RE VERY FORTUNATE TO HAVE WITHIN OUR DEPARTMENT. NEW FORCE POLICIES THAT MOST PERSONNEL HAVE NOW BEEN TRAINED ON. THE CREATION OF THE NEW IMPACT WHICH IS OUR AUDITS AND INSPECTIONS UNIT. AND SIGNIFICANT INCREASES IN THE STAFFING OF INTERNAL AFFAIRS BUREAU AND I.C.I.B. THESE AREAS WERE PREVIOUSLY WOEFULLY INADEQUATE IN THEIR STAFFING AND SUPPORT. THE REDUCTION OF SIGNIFICANT LEVEL 3 FORCE AND AN INCREASE IN LESS SIGNIFICANT FORCE, A POSITIVE INDICATION THAT REPORTING IS MORE DILIGENT AND THAT FORCE INCIDENTS AREN'T ESCALATING, ONLY THE FORCE NECESSARY TO CONTROL THE SITUATION IS, BY AND LARGE, BEING USED. DRAMATIC REDUCTION IN INMATE INJURIES. ROTATION WITHIN FACILITIES AND OTHER MEASURES TO BE ABLE TO GUARD AGAINST DEPUTY CLIQUES AND CREATION OF OPPORTUNITIES FOR ADVANCEMENT WITHIN THE CUSTODY ENVIRONMENT AND A CAREER IN CUSTODY. ALSO, I'VE SET A CLEAR TONE OF ACCOUNTABILITY AND MADE MY EXPECTATIONS OF OUR PERSONNEL TO MAINTAIN THE HIGHEST LEVELS OF PROFESSIONALISM. I'M ALSO PERSONALLY INVOLVED IN ENGAGING IN DISCIPLINARY DECISIONS. THERE IS, HOWEVER, STILL CRITICAL WORK IN PROGRESS AND ONGOING WORK TO BE DONE. SOME OF THOSE AREAS INCLUDE ONGOING TRAINING ENHANCEMENTS, INCLUDING IN ETHICS AND WORKING WITH THE MENTALLY ILL. IN DECEMBER, A TREMENDOUS MENTAL HEALTH C.I.T. TRAINING AND TRAIN THE TRAINER CLASS WAS HELD IN PARTNERSHIP WITH THE N.I.C. I HAD THE OPPORTUNITY TO GO TO THE GRADUATION FOR THAT AND JUST IN TALKING TO OUR OWN PERSONNEL WITHIN THE ORGANIZATION PROFOUND DIFFERENCES IN THE WAY THAT THEY HAD BEEN TRAINED PREVIOUSLY. MANY CITED INCIDENTS WHERE IF THEY HAD THIS TRAINING IN THEIR OWN PERSONAL LIVES, THEY WOULD HAVE BEEN ABLE TO DEAL BETTER WITH PEOPLE WHO HAD MENTAL HEALTH CHALLENGES. SO THE TAKE-AWAY FROM THAT WAS VERY PERSONALLY FELT BUT ALSO VERY VALUABLE TO WHERE WE ARE MOVING FORWARD SO EXCITED ABOUT THAT. A GREATER FOCUS, AS WELL, ON SUPERVISION, DATA TRACKING AND TECHNOLOGY IMPLEMENTATION, THE USE OF BODY SCANNERS, A FULLY SEPARATE CUSTODY TRACKING SYSTEM FOR INMATE GRIEVANCES, AND A FULL BUILD OUT OF THE AUDIT AND INSPECTIONS FUNCTION THAT'S BEING PHASED IN AS FUNDING BECOMES AVAILABLE. RESOURCES WILL BE NEEDED TO BRING A NUMBER OF THESE AREAS TO FRUITION. SO THIS WORK OVERALL IS VITALLY IMPORTANT TO OUR DEPARTMENT, THOSE ENTRUSTED TO OUR CARE AND THE ENTIRE COMMUNITY. I'M COMMITTED TO PRIORITIZING CUSTODY AND ENSURING THAT WE WORK WITH THE BOARD AS WELL AS OUR COUNTY PARTNERS TO FULLY IMPLEMENT ALL OF THE C.C.J.V. RECOMMENDATIONS AND ALSO TO WORK WITH OUR JUSTICE SYSTEM PARTNERS TO DEVELOP NEW APPROACHES TO PREVENTION AND DIVERSION FOR THOSE THAT NEEDN'T BE IN OUR JAILS AND CAN SAFELY BE RETURNED TO THE COMMUNITY. WE CAN GET THIS RIGHT, AND I'M COMMITTED TO ENSURING THAT WE DO GET THIS RIGHT, WORKING IN PARTNERSHIP WITH THE BOARD. LET ME NOW KICK IT OVER TO ASSISTANT SHERIFF MCDONALD TO PROVIDE A MORE DETAILED UPDATE. TERRI? 

ASST. SHERIFF TERRI MCDONALD: THANK YOU, SHERIFF. I.G. DO YOU WANT TO GO FIRST OR WANT ME TO GO AHEAD AND DO YOUR PRESENTATION? 

MAX HUNTSMAN: WHY DON'T YOU GO AHEAD. 

ASST. SHERIFF TERRI MCDONALD: GOOD MORNING, MR. MAYOR, MEMBERS OF THE BOARD, THANK YOU SO MUCH. TERRI MCDONALD, ASSISTANT SHERIFF OVER CUSTODY DIVISION THE LAST TIME WE MET, I WAS ASKED TO FOCUS SPECIFICALLY AND PRIMARILY ON THE OUTSTANDING ITEMS ON THE REPORT. AND SO IN FRONT OF YOU, YOU'LL SEE THE VARIOUS SECTIONS OF THE C.C.J.V. REPORT AND WHERE WE ARE. I'M GOING TO THANK THE BOARD. THE FUNDING IS IN PLACE AND HAS BEEN ALLOCATED FOR EACH OF THESE AREAS. BUT THE TRUTH OF THE MATTER IS: SOME OF THEM JUST TAKE LONGER TO DO. SO I'LL COVER EACH ONE AND PLEASE STOP ME IF YOU WANT AS WE MOVE FORWARD. SO SOME OF THE CHALLENGES ARE JUST DATA TRACKING, HOW WE TRACK DATA. AND SO WE WERE ASKED TO DO A MORE COMPREHENSIVE STREAMLINED AND SOLE SOURCE DATA TRACKING SYSTEM. WE ARE ON TARGET FOR THAT. BUT YOU CAN SEE THAT'S REALLY DECEMBER OF 2016. SO UNFORTUNATELY I'M NOT GOING TO BE ABLE TO COME IN EACH QUARTER AND SAY MAGIC HAS HAPPENED SINCE WE LAST SPOKE. BUT THE I.T. INFRASTRUCTURE IS IN PLACE NOW, AND WE CONTINUE TO DEVELOP THE PROGRAMS. THIS ULTIMATELY WILL REPLACE TWO OTHER SYSTEMS THAT WE UTILIZE TO TRACK VARIOUS LEVELS OF INFORMATION AS WE GO FORWARD AND THEY'LL BE REFERRED TO AS CARTS: CUSTODY AUTOMATED REPORTING TRACKING SYSTEM. BODY SCANNERS, WE WERE ORIGINALLY FUNDED FOR APPROXIMATELY 20 BODY SCANNERS. WE WENT OUT WITH A PILOT WITH 3 OF THEM BECAUSE ONE OF MY PRIMARY CONCERNS IS WE GOT THE APPROVAL TO DO THE EQUIPMENT, BUT WE DIDN'T GET STAFF TO IMPLEMENT THE EQUIPMENT. SO WE STARTED WITH THE PILOT. WE PUT TWO IN THE MALE FACILITIES WHERE WE HAVE PRIMARY INTAKE INTO THE SYSTEM, I.R.C., THE INMATE RECEPTION CENTER FOR MALES, AS WELL AS THE COURT LINE BOOKING AREA. AND WE JUST GOT THE ONE ON THE FEMALE FACILITY AT C.R.D.F. SINCE THAT TIME, WE'VE HAD SOME CHALLENGES. SOME ARE JUST TRAINING. SOME ARE EQUIPMENT CHALLENGES. BUT ALL IN ALL, THE SYSTEMS ARE PROVING POSITIVE. YOU CAN SEE THAT WE'VE HAD IN THE MEN'S SYSTEM, WE'VE HAD OVER 3,000 INMATES SCANNED IN A VERY SHORT PERIOD OF TIME. AND THE WOMEN'S SYSTEM ABOUT 585. WE FOUND SOME BULLETS. WE FOUND SOMEWHERE HEROIN BUT ALL IN ALL NOT LIKE MAJOR-MAJOR CONTRABAND IS COMING IN THE ENTRY PORTAL AREAS. SOME OF THE CHALLENGES I MENTIONED IS THAT THEY'RE STAFF INTENSIVE. AND I KNOW THAT IT'S KIND OF DIFFICULT TO QUANTIFY, BUT IT'S MUCH LIKE MOVING THROUGH THE AIRPORT SCREENING MECHANISM, THAT YOU HAVE FLOW PROBLEMS. THERE ARE TIMES IN WHICH LOTS OF INMATES ARE COMING IN IN BUSES BECAUSE COURT'S OVER OR STATE LINE'S COMING IN. AND THERE ARE OTHER TIMES IN WHICH THE FLOW'S PRETTY LOW. SO WE'VE HAD TO LEARN TO ADJUST TO THE EBB AND FLOW OF POPULATION COMING IN. THE EQUIPMENT'S LARGE. IT TAKES UP AN ENORMOUS AMOUNT OF FLOOR SPACE. THESE JAILS WEREN'T BUILT WITH THIS EQUIPMENT IN MIND. SO FINDING LOCATIONS IN WHICH WE CAN RUN THIS EQUIPMENT AND PLACE THE EQUIPMENT HAS BEEN A CHALLENGE. WE DID HAVE A SCANNER MALFUNCTION AT THE RECEPTION CENTER. WE GOT WATER ON IT BECAUSE OF THE ROOF. AND THE SYSTEM WENT DOWN AND IT TOOK QUITE A BIT OF TIME TO GET THE VENDOR TO REPAIR IT. IT'S SINCE BEEN REPAIRED. UNFORTUNATELY IT WAS DOWN LONGER THAN I PERSONALLY HAD REALIZED AND I PROBABLY COULD HAVE GOTTEN INVOLVED SOONER TO GET IT UP AND RUNNING BUT IT'S UP NOW. WE WERE ASKED TO TAKE A LOOK AT WHERE WE HAD PLACED DEPUTIES AND CUSTODY ASSISTANTS DOING CLERICAL FUNCTIONS. WE WORKED WITH THE C.E.O.'S OFFICE AND FOUND 19 POSITIONS THAT WE HAD PLACED DEPUTIES AND CUSTODY ASSISTANTS IN THAT WOULD BE BETTER MANAGED BY LOWER EXPENDITURE AND PROBABLY MORE APPROPRIATE STAFF. C.E.O.'S OFFICE AND THE BOARD AUTHORIZED 19 POSITIONS. AND WE'RE IN THE PROCESS OF FILLING THOSE. WE SHOULD BE COMPLETE WITH THAT SECTION BY APRIL 15TH. AND THOSE STAFF THAT ARE IN THE POSITION ARE BEING PLACED BACK INTO THE JAILS WHERE THEY MORE APPROPRIATELY BELONG. THE SHERIFF HAD MENTIONED THE IMPACT UNIT. THIS IS AN INTERNAL AUDITING UNIT. THE BOARD HAS GIVEN US POSITIONS IN A THREE-PHASE HIRING. PHASE 1 WAS COMPLETED LAST YEAR. PHASE 2, WE'RE STILL IN THE PROCESS OF PHASE 2 HIRING. THAT SIMPLY MEANS THIS FISCAL YEAR. TWO CHALLENGES. ONE HAS BEEN GETTING THE HEAD COMPLIANCE OFFICER SELECTED AND CHOSEN. WE HAVE THAT PERSON. THEY'RE GOING THROUGH BACKGROUND NOW. AND SO HOPEFULLY THAT GETS COMPLETED PRETTY QUICKLY. AND THEN JUST A TESTING PROCESS FOR A NEW SPECIALIZED CLASSIFICATION OF AUDITORS. AND WE'RE IN THE PROCESS OF DOING THAT. AND THEN PHASE 3 WILL BEGIN IN JULY OF 2015. TRAINING WAS A BIG PORTION OF C.C.J.V. YOU CAN SEE WE HAD SOME JUNE 2015 GOALS. SO THE FIRST ONE INTERACTING WITH MENTALLY ILL INMATES. WE'RE AT 61 PERCENT FOR 60 PERCENT, 49 PERCENT. AND YOU COULD SEE ALL THE WAY DOWN THE ROW. I WOULD HAVE LITTLE CONCERN ABOUT HITTING THESE TARGETS BUT FOR THE FACT THAT UNDER ROSAS, SOME OF THESE CLASSES ARE GOING TO NEED TO BE RE-TOOLED. SO WE'LL HAVE TO DEAL WITH THESE WITHIN THE ROSAS TIME FRAMES. BUT WE WERE ON TARGET UNTIL ROSAS CAME ALONG. ONE OF THE ISSUES THE SHERIFF MENTIONED WAS OUR DELAY AND QUALITY OF INTERNAL AFFAIRS INVESTIGATION. THE BOARD'S AUTHORIZED HIRING FOR BOTH INTERNAL AFFAIRS AND I.C.I.B. YOU CAN SEE ABOVE THAT WE FILLED ALMOST ALL THE POSITIONS. THE I.A.B. CASELOAD IS NOW DOWN TO 10 CASES PER INVESTIGATOR. IT WAS SIGNIFICANTLY HIGHER WHEN C.C.J.V. BEGAN. AND IT'S TAKING NINE MONTHS PER CASE. WE'RE TRYING TO, IN THE NEXT PHASE, GET THAT DOWN TO APPROXIMATELY SIX MONTHS PER CASE SO THAT WE CAN GET THESE I.A.'S CLEARED AND GET MOVING WITH EMPLOYEE DISCIPLINE OR GET THEM OUT OF THE ISSUE OF DISCIPLINE AND THEY CAN FOCUS MORE ACUTELY ON THEIR JOBS. I.C.I.B. ARE THE CRIMINAL INVESTIGATIONS. AND YOU SEE, AS WELL, WE'RE DOWN TO LESS THAN FIVE MONTHS. AND WITH PHASE 3, 13 ITEMS WE'RE GOING TO TRY TO GET IT TO LESS THAN 90 DAYS. INMATE GRIEVANCES, I MENTIONED THIS ON PROBABLY EVERY TIME I'M HERE. IT IS A SUBSTANTIAL CHALLENGE FOR THE JAIL SYSTEM. THE GRIEVANCES IN THE COUNTY DON'T MEET NATIONAL STANDARDS FOR GRIEVANCES. THE INFRASTRUCTURE IS VERY DIFFICULT. IT HAS COME UP UNDER ROSAS. SO IT'S ONE OF THE ISSUES THAT WE HAVE TO SOLVE, TOO, IN THE ROSAS. WE HAVE ASKED FOR RESOURCES TO DO IT. THE RESOURCES INCLUDE I.T. INFRASTRUCTURE AND STAFF. BUT THIS GRIEVANCE ITEM PROBABLY WOULD BE MORE APPROPRIATELY ANSWER 2 UNDER THE ROSAS SETTLEMENT THAN O.I.G. BECAUSE THEY'RE GOING TO KIND OF GIVE US LEADERSHIP ON HOW THEY'D LIKE TO SEE THAT CHANGED. C.C.T.V. SYSTEM. THESE ARE THE VIDEO CAMERAS WITHIN THE JAILS. WE EXPANDED WITHIN THE BASIN JAIL, THAT'S I.R.C., MEN'S CENTRAL JAIL AND TWIN TOWERS. WE FOUND, AFTER WE DID THE ORIGINAL DEPLOYMENT, WE HAD BLIND SPOTS. SO WE PUT ADDITIONAL CAMERAS IN THERE. YOU CAN SEE WE ADDED 354 CAMERAS. THEY ARE IN PLACE. WE'RE FINALIZING THE STORAGE TO THOSE CAMERAS. BUT NO SIGNIFICANT BARRIERS THERE. IT'LL ACTUALLY HELP US TO EVALUATE FORCE, ALSO IDENTIFY CRIMINAL CONDUCT BY INMATES IN THE FACILITY FOR PROSECUTION. AND IT ALSO ALLOWS US TO CLEAR ALLEGATIONS OF FORCE THAT WERE NOT ACCURATE ALLEGATIONS FROM INMATES. WE ARE NOW MOVING INTO THE WOMEN'S FACILITY. WE'LL HAVE THE WOMEN'S FACILITY TOTALLY DONE BY 2015. AND WE'RE STARTING THE UPGRADES AND INSTALLATION AT P.D.C. TOWARDS THE END OF 2015 AND COMPLETE THOSE JAILS UP THERE. THERE'S FOUR OF THEM BY 2018. I'M SORRY. I LOOKED AT THIS AND THERE'S NO HEADER ON THESE CATEGORIES. BUT THIS IS REALLY JUST A SUMMARY. AND I THINK IT GOT ELIMINATED WHEN WE RE-DID THE SLIDE. IT'S A SUMMARY OF THE VARIOUS STAFFING ISSUES. THE FIRST COLUMN IS WHAT THE TOTAL STAFFING WAS. THE SECOND COLUMN WOULD BE PHASE ONE FUNDING, PHASE 2 FUNDING, THE THIRD COLUMN PHASE THREE FUNDINGS, THE FOURTH COLUMN. THE LAST COLUMN IS WHERE WE HAVEN'T FILLED YET BUT WE'RE FUNDED FOR. SO IF YOU SEE 4.12, I MENTIONED THE IMPACT ITEMS, THERE'S 13 THAT WE HAVEN'T FILLED YET. CUSTODY TRAINING, THERE'S ONE POSITION WE HAVEN'T FILLED. 6.05 ARE THE SERGEANTS. IT'S 26 ITEMS. WE HAVEN'T FILLED A SERGEANT, BUT WE'RE FILLING THE POST ON OVERTIME. AND SO THE POST IS FILLED. WE JUST DON'T HAVE ENOUGH SERGEANT BODIES RIGHT NOW TO FILL EVERY POST, BUT WE'RE COVERING THE POSITIONS THROUGH OVERTIME. 

SUP. ANTONOVICH, MAYOR: THE PEOPLE WHO ARE OCCUPYING THOSE POSITIONS, WHO'S OCCUPYING THEIR POSITION THAT THEY OUGHT TO BE RESPONSIBLE FOR? 

ASST. SHERIFF TERRI MCDONALD: SO THEY'RE WORKING THEIR NORMAL SHIFT, MR. MAYOR, AND THEN THEY'RE DOING AN OVERTIME SHIFT AFTERWARDS. SO, FOR EXAMPLE, THEY WORKDAY SHIFT IN TWIN TOWERS AND THEN P.M. SHIFT ON AN OVERTIME SHIFT, THEY'RE WORKING A POST. 

SUP. ANTONOVICH, MAYOR: SO THEY REVERT TO A SERGEANT STATUS FOR THE P.M.? 

ASST. SHERIFF TERRI MCDONALD: YES. AND THEN I.A.B., ONE POSITION. SO ALL IN ALL, WE'VE DONE A PRETTY GOOD JOB ON GETTING HIRING DONE OF ALL THE POSITIONS THAT YOU'VE ALLOCATED FOR US. A COUPLE OF ISSUES CAME UP DURING THE O.I.G. REPORT AND I WANTED TO GIVE A QUICK REPORT BACK ON USE OF FORCE. I REPORTED LAST TIME THAT I WAS HERE THAT IN GENERAL WE WERE UP ABOUT 5 PERCENT ON THE TOTAL NUMBER OF USE OF FORCE INCIDENTS OVER THE PRIOR YEAR. THAT HELD TRUE FOR THE REST OF THE YEAR. TWIN TOWERS, THE MENTAL HEALTH FACILITY, FORCE IS DOWN, BUT MEN'S CENTRAL JAIL, C.R.D.F., UP AT PITCHES DETENTION CENTER, AT NORTH N.C.C.F. FORCE WAS UP SLIGHTLY. IT TRENDED UP SIGNIFICANTLY DURING THE SUMMER, WHICH YOU WOULD FIND IN PATROL, AS WELL. IT'S PRIMARILY RESCUE FORCE. BUT IT IS AN AREA IN WHICH WE ARE PAYING ATTENTION TO. IT HAS TRENDED DOWN SO FAR DECEMBER/JANUARY, BUT WE'RE CONTINUING TO WATCH IT. THE O.I.G. REPORT HAD A COUPLE OF AREAS OF CONCERN THAT I SHOULD SPEAK TO. ONE OF THEM HAD TO DO WITH THE TIMELINESS AND THE QUALITY OF PROBATIONARY PERFORMANCE EVALUATIONS. THIS IS AN AREA IN WHICH WE AGREED TO DO A SIX-MONTH EVALUATION ON PROBATIONARY EMPLOYEES. AND, FRANKLY, IT'S ON ME. WE DIDN'T DO A GOOD JOB OF TRACKING IT AT THE UNIT LEVEL. SO EACH JAIL WAS SUPPOSED TO TRACK IT ON THEIR OWN. WE DIDN'T CENTRALIZE THE TRACKING. I JUST LOSS SIGHT OF IT. SO WE'LL IMPROVE THAT TRACKING AT THE SIX-MONTH LEVEL. THE OTHER HAS TO DO WITH THE QUALITY OF THE FINAL PROBATIONARY EVALUATION. IT'S AN AREA THAT WE HAVE TO CONTINUE TO WORK ON. IT'S BEEN STRAINED BY TURNOVER OF SERGEANTS. BUT ONE IN WHICH WE'LL HAVE TO CONTINUE TO IMPROVE. AND I REMAIN AVAILABLE FOR ANY QUESTIONS THAT YOU MAY HAVE. 

SUP. ANTONOVICH, MAYOR: THE UNFILLED POSITIONS THAT YOU HAVE, WHEN IS YOUR NEXT ACADEMY? 

ASST. SHERIFF TERRI MCDONALD: THAT'S A GOOD QUESTION. WE GOT ONE GRADUATING NEXT WEEK. WE'RE TRYING TO RUN AS MANY ACADEMIES AS WE CAN. WE RAN SIX LAST YEAR. WHAT WE'RE TRYING TO DO, THOUGH, IS TO HIRE CUSTODY SERGEANTS. SO THESE ARE CUSTODY SERGEANTS THAT TAKE THE TEST FOR CUSTODY SERGEANT. THAT NEXT EXAM THE RESULTS ARE COMING UP IN THE SPRING. SO WE'RE HOLDING HIRING THE NEW CUSTODY SERGEANTS UNTIL WE GET THE EXAM RESULTS. 

SUP. ANTONOVICH, MAYOR: BUT FOR THE DEPARTMENT, FOR THE SWORN DEPUTY, FACTORING IN ATTRITION, HOW MANY VACANCIES ARE YOU PROJECTING YOU WILL HAVE? AND WHEN IS THE ACADEMY TO BE SCHEDULED FOR THOSE REPLACEMENTS? 

ASST. SHERIFF TERRI MCDONALD: I'LL HAVE TO GET THAT FOR YOU, SIR. I DON'T HAVE IT. BUT WE WILL GET IT TO YOU. IT WILL BE A SIGNIFICANT ISSUE FOR THE COUNTY ACADEMIES UNDER ROSAS AND D.O.J., KEEPING UP WITH ATTRITION AND GROWTH WILL BE A CHALLENGE FOR US, BUT WE'LL GET TO YOU WHAT THE ATTRITION AND THE NEW ACADEMY. 

SUP. ANTONOVICH, MAYOR: I WOULD SAY IN THE PAST, THERE WAS HIRING OF MANY PEOPLE WHO OUGHT NOT TO HAVE BEEN HIRED BECAUSE THEY DID NOT HAVE THE -- LET'S SAY THE INTEGRITY OR THE QUALIFICATIONS TO BE HIRED IN THE FIRST PLACE. THERE WAS A LOT OF MISTAKES BEING MADE. AND IT WOULD SEEM TO ME THAT YOU WANT TO HAVE ON GOING INTERVIEWING, INVESTIGATING BACKGROUND CHECKS SO THAT WHEN THE ACADEMY DOES OPEN, YOU DON'T HAVE TO GO OUT AND THEN START LOOKING FOR CANDIDATES; THEY'RE ALREADY IN PLACE AND YOU CAN BRING THEM IN. BECAUSE I KNOW SOME OF OUR SMALLER DEPARTMENTS USING RIO HONDO, ET CETERA, ARE HAVING POLICE OFFICERS GOING THROUGH THE ACADEMY AND THEN THEY GO TO THE DEPARTMENT, ONE OF THE DEPARTMENTS. 

SHERIFF JIM MCDONNELL: RIGHT. THAT'S AN ON GOING CHALLENGE. WE'RE COMPETING WITH ALL THE OTHER AGENCIES, TOO, WHO ARE ALSO HIRING AT THE SAME TIME. I THINK WE'LL BE IN A BETTER POSITION MOVING FORWARD WITH THE DUAL TRACK SYSTEM. A LOT OF TIMES YOU'D HAVE CANDIDATES WHO LOOK AT THE VARIETY OF DIFFERENT DEPARTMENTS WHO ARE HIRING AND THEY WOULD COME TO THE SHERIFFS AND THEY WOULD SEE THEY WOULD HAVE TO DO SIGNIFICANT TIME IN CUSTODY AND THEY WOULD JUST CROSS THAT OFF THEIR LIST AND GO SOMEWHERE ELSE. SO THE OPPORTUNITY COST FOR LEADERSHIP AND GOOD DEPUTIES WAS SIGNIFICANT. SO BY ADDRESSING THAT ISSUE, I THINK WE'LL BE MORE COMPETITIVE WITH OTHER ORGANIZATIONS AS WE MOVE FORWARD. 

SUP. ANTONOVICH, MAYOR: AND ON YOUR REPORT TO US WHERE YOU INDICATED THE NUMBER OF ITEMS FROM THE RECOMMENDATIONS FROM THE JAIL COMMISSION, THE 60 THAT WERE BEING RECOMMENDED, YOU HAVE 45 HAVE BEEN IMPLEMENTED, THEN YOU HAVE 10 PARTIALLY AND 5 IN PROGRESS. PERHAPS YOU CAN GIVE US A TIMELINE? I KNOW THERE WERE SOME DISCUSSIONS ON THOSE 60 RECOMMENDATIONS. THERE ARE 63, BUT 3 OF THOSE ARE NOT RELATED TO THE SHERIFF'S DEPARTMENT. THERE WERE SOME POINTS BEING RAISED WHERE IT COULD NOT BE IMPLEMENTED AS BEING SUGGESTED BECAUSE OF CERTAIN REASONS. BUT WE COULD HAVE KIND OF A TIMELINE AND A LITTLE MORE DISCUSSION SO THAT ALL BOARD MEMBERS AND OUR TWO NEW MEMBERS UNDERSTAND WHAT WE HAVE BEEN DOING, WHERE WE ARE AND HOW WE'RE GOING TO IMPLEMENT THOSE RECOMMENDATIONS. 

ASST. SHERIFF TERRI MCDONALD: SURE. 

SUP. ANTONOVICH, MAYOR: QUESTIONS OF MEMBERS? ACTUALLY, YOU WERE GOING TO MAKE YOUR STATEMENT? 

MAX HUNTSMAN: THANK YOU VERY MUCH, MR. MAYOR. IF THERE ARE NO QUESTIONS DIRECTLY TO THAT? 

SUP. ANTONOVICH, MAYOR: SUPERVISOR SOLIS? 

SUP. SOLIS: I APPRECIATE YOUR PRESENTATION. I HAVE A LOT OF QUESTIONS, BUT I THINK I CAN PROBABLY FOLLOW UP WITH YOUR STAFF. I THINK THAT, FIRST OF ALL, I WANT TO COMMEND OUR NEW SHERIFF. AND OBVIOUSLY THE TEAM THERE WORKING TOGETHER TO TRY TO GET A HANDLE ON SOME OF THESE AREAS, AND ESPECIALLY WITH THE CURRENT INVESTIGATIONS THAT ARE ONGOING NOW, PARTICULARLY AT CENTURY STATION AND ALL THOSE ISSUES, I WANT TO COMMEND YOU FOR THAT. AND ALSO WE'LL WANT TO GO BACK TO CUSTODY TRAINING AND THE LENGTH OF TIME BECAUSE I KNOW I'VE HAD SOME DISCUSSIONS WITH FOLKS ABOUT THAT. AND WHAT A BETTER TRACK MIGHT BE SET. WHAT'S THE LENGTH OF TIME? WHAT KIND OF REAL SCREENING OCCURS SO THAT WE CAN MAKE THOSE BETTER DECISIONS AND GET THE RIGHT FOLKS IN THE RIGHT TYPE OF CAREER PATH. THAT'S OF GRAVE CONCERN. BUT ALSO MOVING PEOPLE UP THE CAREER LADDER TO BECOME SERGEANTS WHEN THEY ARE GOING TO BE INVOLVED IN CUSTODY. WHAT ARE SOME OF THOSE CHANGES THAT ARE GOING TO BE HAPPENING THAT ARE NECESSARY? I UNDERSTAND THAT'S PROBABLY A GRAVE CONCERN TO MANY OF US. AND THEN THE SCANNERS, I KNOW MY STAFF HAS RAISED THAT ISSUE. I GUESS I JUST WANT TO UNDERSTAND BETTER HOW WE CAN TRY TO GET TO ANY ISSUES WHERE WE HAVE COMPLAINTS FROM INMATES REGARDING UNNECESSARY SEARCHES. WHY MAYBE THERE WAS A NEED TO HAVE THE SCANNERS AS WELL FOR OTHER REASONS SO THAT, FOR EXAMPLE, WOMEN WOULDN'T HAVE TO BE MISTREATED IN A DIFFERENT MANNER WHEN THEY WERE BEING BODY SEARCHED, WHAT HAVE YOU. SO I THINK THOSE ARE VALID ISSUES TO RAISE. MAYBE WE CAN GET BACK WITH YOU AND YOU CAN FILL US IN MORE ON THAT. I UNDERSTAND THAT YOU DON'T HAVE THE STAFF TO MAN ALL THE SCANNERS NOW, BUT THERE ARE OTHER ISSUES. I LOOK FORWARD TO WORKING WITH THE SHERIFF. THANK YOU FOR THE TOUR YOU PROVIDED ME EARLY ON BEFORE I BECAME SUPERVISOR. IT WAS VERY, VERY IMPORTANT FOR ME TO UNDERSTAND MUCH OF WHAT I HAD BEEN HEARING ABOUT AND HAD BEEN READING ABOUT. SO I APPRECIATE THAT OPPORTUNITY. 

SUP. ANTONOVICH, MAYOR: SUPERVISOR KUEHL? 

SUP. KUEHL: THANK YOU, MR. MAYOR. IT'S INTERESTING TO ME THAT THE PHRASE "THERE'S A NEW SHERIFF IN TOWN" HAS COME TO MEAN MORE THAN THERE'S A NEW SHERIFF IN TOWN WHEN PEOPLE SAY IT. AND NORMALLY USE THE PHRASE TO MEAN THERE'S SOMETHING NEW HAPPENING. AND MOST OF THE TIME THEY THEY MEAN THERE'S SOMETHING GOOD NEW HAPPENING, MAYBE NOT ALWAYS. IN THIS CASE I THINK IT IS THE CASE. AND AS YOU SAY, SHERIFF, A LOT OF WORK STILL REMAINS. AND I WANT TO COMMEND YOU AND YOUR STAFF. AND CERTAINLY LOOK FORWARD TO NEXT REPORT, AS WELL. BECAUSE IT SEEMS AS THOUGH OUR TRYING TO KNIT ALL OF THIS TOGETHER WITH THE INSPECTOR GENERAL WITH THE NEW PROCEDURES AND PERSONNEL WITH THE OVERSIGHT COMMISSION THAT COULD INDEED BE A RESTORATION OF TRUST AND EVEN A FEELING OF IMPRESSIVENESS, PERHAPS, ABOUT OUR SHERIFF'S DEPARTMENT. I HAVE A QUESTION ABOUT THE SCANNERS. I WAS STRUCK, OF COURSE, THAT WE SCANNED 3,000 PEOPLE AND WE FIND A BULLET. WE SCAN 600 PEOPLE AND WE FIND, VERY IMPORTANTLY, SOME HEROIN. BUT WHEN SUPERVISOR SOLIS WAS TALKING I WONDER DO THE SCANNERS HELP IN ANY WAY WITH THE NEED FOR INVASIVE SEARCHES? SO THAT OBVIOUSLY SUPERVISOR SOLIS AND I HAVE RECEIVED MORE THAN ONE REPORT FROM WOMEN AND THEIR FAMILIES WHO HAVE GONE THROUGH SOME VERY INVASIVE SEARCHES, AND MORE THAN ONCE IN ONE TRIP, TO COURT AND BACK, ET CETERA. AND I UNDERSTAND THE NEED FOR SAFETY AND PRECAUTION, BUT I WONDER WHETHER THE INVESTMENT THAT WE'RE MAKING IN THE SCANNERS AND PERSONNEL HELP IN ANY WAY WITH OUR CONCERN ABOUT THOSE, THE NEED FOR THOSE SEARCHES. 

ASST. SHERIFF TERRI MCDONALD: YES, MA'AM. THE BODY SCANNERS DO ALLOW US NOT TO DO AN UNCLOTHED. BODY SEARCH, WHICH IS REALLY FANTASTIC FOR ALL OF US. IN THE WOMEN'S FACILITY, THEY'RE ALL OFFERED THE SCANNER. A PREGNANT FEMALE MAY CHOOSE NOT TO DO IT FOR FEAR OF RADIATION EXPOSURE. BUT IN THE WOMEN'S FACILITY, THAT'S WHAT WE USE THERE NOW, WHICH IS GREAT. AND I THINK IT'S IMPORTANT FOR EVERYBODY TO UNDERSTAND: WE'RE GOING TO CONTINUE TO EXPAND THE SCANNERS. I THINK THERE'S BEEN A LITTLE MISCOMMUNICATION ON MY PART, WHICH IS RIGHT NOW WE'RE JUST TRYING TO FOCUS ON THE ROSAS- D.O.J. BUT AS SOON AS WE GET THROUGH THAT IMPORTANT PROJECT, WE'LL GO BACK TO FIGURE OUT HOW WE BEST EXPAND THE SCANNERS IN A RESPONSIBLE WAY. SO LONG ANSWER, SHORT QUESTION, YES, IT DOES HELP SIGNIFICANTLY WITH THE UNCLOTHED BODY SEARCH ISSUE. 

SUP. KUEHL: THANK YOU VERY MUCH. 

SUP. ANTONOVICH, MAYOR: NEXT? 

MAX UNTSMAN: THANK YOU, SIR, MR. MAYOR, SUPERVISORS, I'M GOING ASK ASSISTANT INSPECTOR GENERAL KATIE BELTZ IN CHARGE OF MONITORING AND COMMUNITY OUTREACH TO SAY A BRIEF FEW WORDS ABOUT THE REPORT AND THEN WE CAN ANSWER ANY QUESTIONS YOU MIGHT HAVE. 

CATHLEEN BELTZ: GOOD AFTERNOON. MY NAME IS CATHLEEN BELTZ, ASSISTANT SECRETARY INSPECTOR GENERAL, L.A. COUNTY OFFICE OF THE INSPECTOR GENERAL. SINCE THE O.I.G. SUBMITTED OUR FIRST STATUS REPORT AND MONITORING PLAN RELATED TO THE THIRD QUARTER 2014, THE DEPARTMENT HAS INDEED MADE ADDITIONAL PROGRESS IN SEVERAL AREAS. THERE ARE ITEMS IN OUR REPORT YOU'LL SEE REGARDING OUR MONITORING OF THE C.C.J.V. RECOMMENDATION IMPLEMENTATION. THERE ARE ITEMS IN OUR REPORT THAT ARE IDENTIFIED AS PARTIALLY IMPLEMENTED OR IN PROGRESS. AND THOSE ARE THE ITEMS RELATED TO TRAINING AND STAFFING, ET CETERA, THAT YOU JUST HEARD ABOUT FROM THE SHERIFF AND THE ASSISTANT SHERIFF. THERE ARE ALSO ITEMS, HOWEVER, THAT HAVE BEEN IDENTIFIED AS IMPLEMENTED IN THE REPORT BUT WHICH THE O.I.G. HAS ALSO IDENTIFIED AS REQUIRING ADDITIONAL MONITORING. AND THAT MONITORING IS LARGELY FOR THE PURPOSES OF INSURING THAT THE ITEMS HAVE BEEN IMPLEMENTED FULLY, THAT THEY'VE BEEN WHOLLY INCORPORATED INTO PATROL AND CUSTODIAL PRACTICE AND TO ENSURE THAT THOSE ITEMS HAVE BEEN IMPLEMENTED IN A WAY THAT'S CONSISTENT WITH THE UNDERLYING PRINCIPLES OF THE C.C.J.V. RECOMMENDATIONS. NOW THAT THE ROSAS SETTLEMENT AGREEMENT AND IMPLEMENTATION PLAN HAS BEEN FINALIZED THE O.I.G. IS IN THE PROCESS OF IDENTIFYING AREAS OF OVERLAP BETWEEN C.C.J.V. AND ROSAS. AND OUR PLAN AT THIS POINT IS TO COORDINATE CLOSELY WITH THE ROSAS MONITORS AND WITH THE DEPARTMENT. WE WANT TO WORK DILIGENTLY TO AVOID ANY DUPLICATION OF EFFORT AND AVOID THE POSSIBILITY OF PLACING UNDUE BURDEN ON THE DEPARTMENT OR ON THE COUNTY AND OUR MONITORING OF THESE ITEMS. THAT'S NOT TO SAY THAT WE WON'T MONITOR THE C.C.J.V. RECOMMENDATIONS THAT OVERLAP WITH ROSAS, BUT, RATHER, WE'LL COORDINATE WITH THE DEPARTMENT TO LIKELY PLACE MOST OF THE EMPHASIS IN OUR MONITORING ON THOSE ITEMS WHICH CAN BEST BE EVALUATED AND MONITORED THROUGH REAL TIME MONITORING OR CONSISTENT PRESENCE ON SITE IN FACILITIES. THERE REMAINS OUTSTANDING THE ISSUE OF O.I.G. ACCESS TO PERSONNEL RECORDS AND OTHER INFORMATION THAT IS AT THIS TIME CREATING A SITUATION WHEREBY MUCH OF OUR MONITORING IS FORESTALLED. FOR EXAMPLE, THE DEPARTMENT HAS BEEN EXCEPTIONALLY DILIGENT AND PROACTIVE IN REPORTING TO THE O.I.G. INCIDENTS OF EXCESSIVE USE OF FORCE OR PRISONER HARASSMENT. AND, AS WELL, WHEN THE O.I.G. HAS RAISED CONCERNS AROUND THOSE ISSUES, THE DEPARTMENT'S BEEN VERY RESPONSIVE TO THOSE CONCERNS; HOWEVER, BECAUSE MOST OF THESE ISSUES ARE PERSONNEL-RELATED, WELL VIRTUALLY THE SECOND ANY SORT OF INQUIRY OR OFFICIAL ADMINISTRATIVE INVESTIGATION IS TRIGGERED, THE O.I.G. NO LONGER HAS ACCESS TO THAT PROCESS OR INFORMATION AROUND THAT PROCESS. AND WE'RE AT THAT POINT UNABLE TO ASSESS THE QUALITY OF THE DEPARTMENT'S INVESTIGATION OR INQUIRY INTO THESE MATTERS. SO IT ALSO, THEN, RESULTS IN MUCH OF THE O.I.G.'S CURRENT REPORTING BEING BASED ON DEPARTMENT'S SELF-REPORTING, OR THE O.I.G.'S REVIEW OF SUMMARY DATA OR INFORMATION OR REPRESENTATIONS MADE BY THE DEPARTMENT ON A VARIETY OF ISSUES AS OPPOSED TO THE O.I.G.'S SEPARATE AND THOROUGH REVIEW AND ANALYSIS THAT WOULD BE MUCH MORE CONSISTENT WITH NATIONALLY RECOGNIZED OVERSIGHT METHODS. SO THAT SAID, I'M AVAILABLE, AS WELL, TO RESPOND TO ANY QUESTIONS ABOUT C.C.J.V., THIS REPORT OR IMPLEMENTATION GENERALLY? 

SUP. ANTONOVICH, MAYOR: ANY QUESTIONS? I WOULD WANT TO THANK YOU. WE HAVE SOME PUBLIC COMMENT. PERHAPS YOU WILL BE ABLE TO HEAR THEM WHEN I CALL THEM UP. BUT THANK YOU, SHERIFF, AND MEMBERS. AND APPRECIATE YOU BEING ON BOARD AND WORKING WITH YOU. LET ME CALL UP DR. GENEVIEVE CLAVREUL. MR. ERIC PREVEN, MR. ARNOLD SACHS. 

ERIC PREVEN: YES, IT IS ERIC PREVEN, COUNTY RESIDENT FROM DISTRICT 3. AND IT'S NICE TO SEE SHERIFF MCDONNELL, GOODBYE, SIR, WHO HAS COME TO HIS FIRST MEETING. I HAVE TO SAY I'M A TEENY BIT DISAPPOINTED IN THE REPORT FOR ONE THING. ALL OF THE DATA ABOUT THE USE OF FORCE INCIDENTS THAT ORDINARILY WOULD BE PUBLISHED ON A CHART IS NOW NOT PUBLISHED ON A CHART. THAT CHART IS MISSING AND THAT IS A SERIOUS PROBLEM. WE WANT THAT DATA SO WE CAN TRACK IT REGULARLY. PAGE 12 THAT MS. SHERIFF MCDONALD POINTED TO WAS MISSING ENTIRELY THE TOP HEADING OF CATEGORY. SO IT WAS AN INELIGIBLE REPORT. THAT'S UNFORTUNATE. ITEM 7.14 IN THE PACKET OF THE SHERIFF DEALS WITH INMATE GRIEVANCES. AND I UNDERSTAND THIS HAS BEEN OVERSEEN NOW BY THE ROSAS AGREEMENT, WHICH IS A DEAL BETWEEN THE A.C.L.U. AND THE COUNTY REGARDING SORT OF A CLASS ACTION FROM INMATES, AND I THINK WE NEED TO SEE THE ROSAS REPORT AND UNDERSTAND WHAT THOSE PROVISIONS ARE SPECIFICALLY AND WHERE WE ARE WITH THAT. WE DO KNOW, AND IT IS OF SOME NOTE, MR. SALADINO, THAT MR. DROOYAN, OUR FORMER C.C.J.V. COUNSEL, THEN HE BECAME THE IMPLEMENTATION MONITOR AND WENT INTO A CLOAK OF SECRECY AS TO WHAT HE WAS MAKING AND NOW HE IS A ROSAS MONITOR FOR A COURT SO KUDOS ON FACILITATING THAT. THAT'S REALLY A GOOD WAY TO KEEP THAT GUY IN THE LOOP. I'M NOT SURE IT'S IN THE PUBLIC'S INTEREST BECAUSE OF COURSE HE IS VERY CLOSE TO THAT. H.B.R. CONSULTING IS A GROUP THAT LOOKS AT THE LEGAL COSTS IN THE COUNTY OUTSIDE OF THE SHERIFF'S DEPARTMENT. WE WOULD LIKE TO SEE THAT, TOO, IN REGARD TO THE CALIFORNIA PUBLIC RECORD ACT. THERE WAS ALSO A CASE AND I HAVE TO REFER TO IT THAT THE COUNTY FOUGHT ON APPEAL TO SEQUESTER ALL LEGAL BILLINGS. SUPERVISOR SOLIS, I DIRECT THIS TO YOUR DISTRICT BECAUSE IN PART MOLINA WAS A LEADER THERE. AND IN SEPTEMBER, WE WERE SUPPOSED TO GET THE COST OF LITIGATION INCLUDING THE SHERIFF'S NUMBERS AND EVERYTHING. SHE WAS VERY ADAMANT IT HAS TO COME IN SEPTEMBER. WE ARE NOW FACING AS YOU KNOW FEBRUARY AND IT IS STILL NOT PROVIDED. THE C.E.O. WHO TELLS THE TRUTH KNOWS THE REASON. IT'S BECAUSE IT'S LOG JAMMED IN COUNTY COUNSEL. SO I DO THINK WE SHOULD MOVE THAT FORWARD. IN TERMS OF THE SCANNERS, IF I COULD BE GIVEN AN EXTRA 10 SECONDS, I WOULD LIKE TO, NO? YOU DON'T NEED ANYMORE HELP? 

SUP. ANTONOVICH, MAYOR: NO, NO, YOU'RE ENOUGH. MR. SACHS? 

ARNOLD SACHS: YES, THANK YOU, GOOD AFTERNOON, ARNOLD SACHS AND SOMEWHAT FASCINATING. IT'S INTERESTING FOR ME, ACTUALLY TO KNOW THAT THE NEW SHERIFF AS THE CHIEF OF POLICE IN LONG BEACH, I WONDER IF HE WAS INVOLVED IN THE CONTRACT NEGOTIATIONS, BECAUSE PART OF THE PROBLEM, I BELIEVE, IS THAT THE SHERIFF HAS OVERSIGHT OF THE SHERIFF'S DEPARTMENT, BUT HE HAS NO OVERSIGHT OF THE CONTRACT NEGOTIATIONS WHICH OCCURS WITH THE BOARD OF SUPERVISORS. AND SO YOU BECOME LIKE A THIRD WHEEL THERE. AND HE HAS TO DEAL WITH THE SILVER SERVICE PROTECTION, THE SHERIFF'S BILL OF RIGHTS, AND THOSE SORT OF THINGS. BUT WHAT WAS REALLY INTERESTING WAS THE YOUNG WOMAN WHO JUST SPOKE TALKING ABOUT HOW PERSONNEL RECORDS BECOME INACCESSIBLE. AND I AM PRETTY DARN SURE THAT SUPERVISOR MOLINA HAD THAT PROBLEM WITH THE SHERIFF WHO WAS PUT BACK ON THE FIELD, PUT BACK IN THE FIELD AFTER HE HAD BEEN INVOLVED IN SEVEN SHOOTINGS. AND ONE OF HER MAJOR CONCERNS WAS THAT SHE COULDN'T GET THE INFORMATION FROM COUNTY COUNSEL. AND ONE OF HER MAJOR, MAJOR CONCERNS WAS IF SHE COULDN'T GET THE INFORMATION FROM COUNTY COUNSEL, THEN WHAT WOULD HAPPEN WITH THE OFFICE OF AN INSPECTOR GENERAL MAX HUNTSMAN? AND IT TURNS OUT THEY CAN'T GET THE INFORMATION. IT'S EXACTLY WHAT SHE SAID. SO IN THE 7 OR 8 MONTHS THAT THIS HAPPENED, WHAT HAS CHANGED? EXCEPT THE FACT THAT YOU CHANGED THE ORDINANCE FOR THE -- YOU GOT RID OF THE OFFICE OF INDEPENDENT REVIEW AND YOU PUT THE OFFICE OF INSPECTOR GENERAL AND YOU CREATED SOME SALARY INFORMATION. BUT YOU DIDN'T ADDRESS THE FACT ABOUT THE PERSONNEL RECORDS. SO YOU'RE STILL IN THE SAME BOAT AND IT DOESN'T MATTER WHO YOU PUT IN THERE, YOU'RE STILL IN THE EXACTLY SAME PLACE. BY THE WAY, MISS SOLIS, YOU WENT ON A TOUR OF THE JAILS. BEEN ON A TOUR OF THE BLUE LINE YET? STILL WAITING TO GO. SO, WHAT HAPPENS THERE? WELL, YOU KNOW, THAT'S PART OF IT BECAUSE, YOU KNOW, THAT GRAFFITI, THE BROKEN WINDOW SYSTEM YOU HEAR ABOUT WITH SHERIFFS AND POLICING, THAT'S PART OF THE SYSTEM. THAT'S PART OF THE PROBLEM. AND SO CHECK THAT OUT. ANY TIME YOU'D LIKE TO GO, MISS SOLIS. TOUR. 

SUP. ANTONOVICH, MAYOR: MOTION TO RECEIVE AND FILE BY SUPERVISOR KNABE. SECONDED. WITHOUT OBJECTION, SO ORDERED. AND WE WILL NOW GO INTO ADJOURNMENT MOTIONS. SUPERVISOR SOLIS? 

SUP. SOLIS: THANK YOU. I MOVE THAT WE ADJOURN TODAY IN MEMORY OF ARTHUR ICHIRO MURIKAMI. MR. MURIKAMI WAS BORN DECEMBER 23, 1929 IN LONG BEACH, CALIFORNIA. PASSED AWAY ON JANUARY 14TH AT THE AGE OF 85. HE SERVED IN UNITED STATES ARMY AND RELOCATED TO LOS ANGELES IN 1947 AFTER THE KOREAN WAR. HE EARNED AN ASSOCIATES DEGREE FROM LOS ANGELES CITY COLLEGE AND WORKED IN THE RETAIL GROCERY INDUSTRY FOR OVER 40 YEARS. HE WAS TRAINED JAPANESE KENDO SWORDSMAN AND SERVED AS THE PRESIDENT OF THE ALL UNITED STATES KENDO FEDERATION AND AS VICE PRESIDENT OF THE KENDO FEDERATION. HE HAS ALSO VOLUNTEER INSTRUCTOR AT EAST L.A. COLLEGE, AND INDUSTRY SHERIFF'S YOUTH ACTIVITIES LEAGUE AND WAS HONORED AT NISEI PIONEER IN THE 2012 NISEI WEEK PARADE FOR BEING AN ACTIVE AND DEDICATED COMMUNITY MEMBER. HE'S WELL REMEMBERED BY MANY AND WELL RESPECTED BY MOST. HE IS SURVIVED BY HIS WIFE, LENA, DAUGHTER JULIA, SON TIM AND THREE GRANDCHILDREN, BRITTANY, TIMOTHY AND BETHANY AND FOUR GREAT GRANDCHILDREN AND A HOST OF EXTENDED FAMILY MEMBERS WHO MISS HIM DEARLY. I MOVE THAT WE ADJOURN IN HIS MEMORY. MY SECOND MOTION, I MOVE THAT WE ADJOURN TODAY IN MEMORY OF BOB BAKER. BOB BAKER, ALONG WITH HIS PARTNER, ALTON WOOD FOUNDED THE BOB BAKER MARIONETTE THEATER IN 1963, WHICH HAS GONE ON TO BECOME THE OLDEST PUPPET THEATER IN THE UNITED STATES. IN JUNE 2009, THE THEATER WAS DESIGNATED AS A LOS ANGELES HISTORICAL CULTURAL MONUMENT, AN INNOVATIVE ARTISAN PUPPET MASTER. BOB AND HIS COMPANY HAVE PERFORMED PUPPETS AROUND THE GLOBE. HIS MARIONETTES HAVE ENTERTAINED THOUSANDS OF CHILDREN AND ADULTS WORLDWIDE OVER THE YEARS. BOB BAKER WHO ENTERTAINED GENERATIONS OF ANGELINOS AT HIS PUPPET THEATER DIED LAST YEAR IN NOVEMBER AT THE AGE OF 90 FROM KIDNEY FAILURE. HE'S SURVIVED BY FRIENDS AND LOVED ONES. HE'S HAD DEVOTED EMPLOYEES OVER THE YEARS AND HIS HAND-CRAFTED MARIONETTES. LET'S REMEMBER BOB BAKER AND HIS LIFE'S WORK. THANK YOU. 

SUP. ANTONOVICH, MAYOR: SECOND WITHOUT OBJECTION, SO ORDERED. SECOND DISTRICT, SUPERVISOR MARK RIDLEY-THOMAS. 

SUP. RIDLEY-THOMAS: THANK YOU VERY MUCH, MR. MAYOR AND COLLEAGUES. WOULD YOU PLEASE JOIN ME IN ADJOURNING IN MEMORY OF SYLVIA RENEE BANTON WHO PASSED AWAY ON JANUARY 6TH WHO GREW UP IN CARSON. AT THE AGE OF 20, SHE ENLISTED IN THE UNITED STATES AIR FORCE. WHILE STATIONED IN NEW HAMPSHIRE, SHE WORKED AS AN ACCOUNTANT AND OBTAINED THE RANK OF SERGEANT. SHE EARNED HER BACHELOR'S DEGREE FROM THE UNIVERSITY OF NEW HAMPSHIRE AND AFTER SERVING SEVERAL YEARS IN THE MILITARY, SHE WAS HONORABLY DISCHARGED AND RETURNED TO LOS ANGELES WHERE SHE EXPERIENCED HARDSHIP, HOMELESSNESS AND ADDICTION. IN 2003 SHE ENTERED THE NEW DIRECTION FOR VETERANS WOMEN'S PROGRAM. AND IN 2004 SHE WAS HIRED BY NEW DIRECTIONS AND WORKED IN ACCOUNTS PAYABLE WHILE SHE EARNED A MASTER'S DEGREE IN FAMILY THERAPY FROM THE ANTIOCH UNIVERSITY. IN 2010, SHE WAS APPOINTED AS SUPERVISOR FOR THE NEW DIRECTIONS, AND IN 2011, SHE WAS RECOGNIZED BY THE LOS ANGELES MAGAZINE AS ONE OF THE 50 WOMEN MAKING A DIFFERENCE IN THE COMMUNITY. MRS. BANTON LED A SUCCESSFUL RECOVERY FROM HARDSHIP AS A FEMALE VETERAN. SHE'S HAD PERSONAL KNOWLEDGE OF ISSUES CONFRONTING WOMEN, MANY WOMEN WHO, IN FACT, WERE IN OUR VETERANS. SO IN 2012, HER LIFE WAS SHOW- CASED IN A 24-MINUTE FILM "HER WAR." WHICH BROADCASTED ON PUBLIC TELEVISION AS WELL AS STAGE AS A STAGE PLAY TITLED "A GUIDE TO THE AFTERMATH." SHE LEAVES BEHIND A LEGACY OF WOMEN VETERANS WHO CHANGED THEIR LIVES BEYOND DIFFICULT MEASURE. MRS. BANTON IS SURVIVED BY MANY FAMILY MEMBERS AND FRIENDS WHO WILL INDEED MISS HER DEARLY. MR. MAYOR AND COLLEAGUES, WOULD YOU JOIN ME IN ADJOURNING IN MEMORY OF STERLING SINCORPS. BORN DECEMBER 23, 1922 AND PASSED ON JANUARY 10 AT THE AGE OF 92. AT A YOUNG AGE. HE WAS PROVIDER FOR HIS FAMILY AND WORKED THREE JOBS. IN 1986 HE RELOCATED TO LOS ANGELES WITH HIS WIFE AND CHILDREN. HIS CAREER WAS IN EDUCATION AND WORKED AT THE NEW ORLEANS PUBLIC SCHOOL SYSTEM, LOYOLA UNIVERSITY IN NEW ORLEANS AND AT THE COMPTON UNIFIED SCHOOL DISTRICT HERE. WHILE AT LOYOLA UNIVERSITY HE DEVELOPED THE SPECIALIZED COLLEGE ORIENTATION FOR PERSONAL EDUCATION KNOWN AS SCOPE. HE ALSO HELPED DEVELOP AT THE UNIVERSITY'S FIRST PARTNERSHIP ABROAD WITH PUERTO RICO. HE WAS THE FIRST AFRICAN-AMERICAN ADMINISTRATOR HIRED AT LOYOLA UNIVERSITY AND HIS TENURE IMPACTED THE INTEGRATION OF THAT UNIVERSITY. HE TRAVELED TO OTHER JESUIT INSTITUTIONS TO SUPPORT INTEGRATION INITIATIVES ON THOSE RESPECTIVE CAMPUSES. AFTER MOVING TO LOS ANGELES, HIS AMBITION WAS TO WORK THE MOST ACADEMICALLY AT-RISK STUDENTS IN THE COMPTON UNIFIED SCHOOL DISTRICT AND HIS HARD WORK WAS RECOGNIZED WHEN HE WAS AWARDED TEACHER OF THE YEAR OF THE DOMINGUEZ HIGH SCHOOL. MR. SINCORPS ALSO WORKED AS A MEMBER OF THE STEWARD COMMITTEE OF THE HOLMAN UNITED METHODIST CHURCH. HE WILL BE REMEMBERED FOR HIS STRONG COMMITMENT TO SERVE AND CARE FOR HIS FAMILY, HIS STUDENTS AND OTHERS. HE IS SURVIVED BY HIS WIFE, VERA, THREE CHILDREN, STERLING, JR., LYDIA WHO IS A C.E.O. OF CHILDREN, YOUTH AND FAMILY COLLABORATIVE, AND VERDEALIA, THE GRANDDAUGHTER CARTER AND MANY OTHER FAMILY MEMBERS AND FRIENDS WHO WILL INDEED MISS HIM. HAZEL ISAIAH RAMSON. MR. MAYOR AND COLLEAGUES, BORN FEBRUARY 19, 1928 IN JONES, OKLAHOMA. SHE PASSED AWAY ON JANUARY THE 14TH AT THE AGE OF 87. SHE WAS AN ENTREPRENEUR IN SEVERAL AREAS, INCLUDING THAT OF REAL ESTATE. SHE WAS ALSO A MEMORIAL COUNSELOR OF THE INGLEWOOD CEMETERY AND HELPED MANY FAMILIES THROUGH THEIR TIME OF GRIEF. SHE WORKED WITH THE NATIONAL COUNCIL OF NEGRO WOMEN FOR OVER 40 YEARS. AND SHE WILL BE REMEMBERED FOR HER DEDICATION TO THE COMMUNITY. AND MISS RAMSOM IS SURVIVED BY HER DAUGHTER, ANITA, HER GRANDCHILDREN AARON AND SIMONE, MANY FRIENDS AND FAMILY WHO WILL MISS HER. HAZEL ISAIAH RAMSON. AND, FINALLY, MYRTLE FAY RUMP. BORN FEBRUARY 21, 1931 IN THE GREAT STATE OF TEXAS AND PASSED ON JANUARY THE 7TH AT THE AGE OF 83. IN THE 1950S SHE MOVED TO THE CITY OF INGLEWOOD WITH HER HUSBAND. IN 1989, HER 35-YEAR-OLD SON WAS KILLED BY A DRIVE-BY SHOOTING WHICH CHANGED HER LIFE FOREVER. HIS DEATH INSPIRED HER TO OPEN A CENTER IN 1990 SHE FORMED, WITH THE HELP OF MANY MEMBERS OF THE COMMUNITY, FRIENDS KNOWN AS THE AL WOOTEN, JR. HERITAGE CENTER. THE YOUTH CENTER WAS A SAFE HAVEN FOR YOUTH AND PROVIDED A PLACE FOR PARENTS TO STEER CHILDREN IN THE RIGHT DIRECTION. PROVIDE THE CHILDREN WITH CONSTRUCTIVE ALTERNATIVES TO ADVERSE BEHAVIOR AND TO STOP THE VIOLENCE. SHE RETIRED AS PRESIDENT OF THE CENTER AFTER 20 YEARS OF SERVICE IN 1992 AFTER THE CIVIL UNREST. AL WOOTEN, JR. HERITAGE CENTER WAS FEATURED IN SEVERAL NEWSPAPERS AND MAGAZINES INCLUDING THE "LOS ANGELES TIMES" IN WHICH SHE WAS DECLARED A HOME TOWN HERO. PRESIDENT BARACK OBAMA NAMED HER AS ONE OF THE 13TH RECIPIENTS OF THE ANNUAL PRESIDENTIAL CITIZENS MEDAL. MRS. RUMP WILL BE REMEMBERED FOR HER TENACITY, HER LOVE, HER DEVOTION TO CHILDREN AT THE CENTER AND THE COMMUNITY AT LARGE. SHE IS SURVIVED BY TWO CHILDREN, BARBARA AND THE REVEREND ARTHUR WOOTEN, GRANDCHILDREN, GREAT GRANDCHILDREN, HER SISTER PERLINE AND HER BROTHER JAMES. AND OTHER MEMBERS OF THE COMMUNITY WHO WILL MISS HER AND CHERISH HER MEMORY FOREVER. MYRTLE FAY RUMP, MR. MAYOR AND COLLEAGUES. 

SUP. ANTONOVICH, MAYOR: SECOND WITHOUT OBJECTION, SO ORDERED. SUPERVISOR KUEHL? 

SUP. KUEHL: THANK YOU, MR. MAYOR AND COLLEAGUES. I MOVE THAT WHEN WE ADJOURN TODAY, WE ADJOURN IN MEMORY OF BRIAN KUTIL, AN OCEAN LIFEGUARD SPECIALIST, 20-YEAR LIFEGUARD VETERAN AT THE COUNTY FIRE DEPARTMENT. 

SUP. ANTONOVICH, MAYOR: DO ALL MEMBERS ON THAT. 

SUP. KUEHL: ALL MEMBERS ON THIS, PLEASE. WHO RECENTLY PASSED AWAY AT THE YOUNG AGE OF 42. HE HAD BEEN PARTICIPATING IN THE DEPARTMENT'S ANNUAL 500-METER RE-CERTIFICATION SWIM EXERCISE AT MIRA COSTA HIGH SCHOOL IN MANHATTAN BEACH WHEN IT BECAME CLEAR HE WAS IN DEEP DISTRESS. HE WAS IMMEDIATELY TREATED BY HIS FELLOW COUNTY LIFEGUARDS ALONG WITH MANHATTAN BEACH FIRE DEPARTMENT PARAMEDICS, TRANSPORTED TO LITTLE COMPANY OF MARY HOSPITAL WHERE, DESPITE HEROIC EFFORTS BY ALL INVOLVED, HE WAS PRONOUNCED DEAD. COLLEAGUES REMEMBER HIM WELL AS A GENEROUS, HAPPY-GO-LUCKY GUY AS THEY DESCRIBED HIM. CERTAINLY A PRO. PARTICIPATED IN SAVING SO MANY OF OUR LIVES AND KEEPING US SAFE. AND HIS DEATH MAY BE THE FIRST ON-DUTY LOSS OF LIFE AMONG THE LIFEGUARD CORPS IN COUNTY HISTORY. HE'S SURVIVED BY FAMILY MEMBERS AND HIS MANY FRIENDS AND COLLEAGUES IN THE COUNTY FAMILY. AND MR. MAYOR AND COLLEAGUES, I MOVE THAT WHEN WE ADJOURN TODAY, WE ADJOURN IN MEMORY OF ROBERT IRMAS. A LIFETIME LOS ANGELES RESIDENT OF THE THIRD DISTRICT RECENTLY PASSED AWAY AT THE AGE OF 63 AFTER A COURAGEOUS BATTLE WITH CANCER. GRADUATE OF BEVERLY HILLS HIGH SCHOOL, HE JOINED THE L.A. COUNTY SHERIFF'S DEPARTMENT FOLLOWING HIS FRESHMAN YEAR IN COLLEGE. EVENTUALLY SPENDING EIGHT YEARS THERE. AFTER GRADUATING FROM PEPPERDINE IN 1976, HE WENT ON TO EARN A MASTER'S IN CRIMINAL JUSTICE FROM CHAPMAN UNIVERSITY AND A JURIS DOCTOR FROM SOUTHWESTERN LAW SCHOOL. IN ADDITION TO SERVING IN THE L.A. COUNTY SHERIFF'S DEPARTMENT, HIS CAREER IN LAW ENFORCEMENT ALSO INCLUDED TIME AS A DEPUTY DISTRICT ATTORNEY IN VENTURA COUNTY WHERE HE WAS ALSO A CANDIDATE FOR SHERIFF AND SERVED AS A SHERIFF'S RESERVE DEPUTY. HE SUBSEQUENTLY TURNED HIS CAREER ATTENTION TO COMMERCIAL REAL ESTATE, BUT IN HIS PRIVATE LIFE HE PURSUED EXTENSIVE PHILANTHROPIC ACTIVITIES, INCLUDING THE SUCCESSFUL CONSTRUCTION FOR 3,000 SQUARE FOOT YOUTH ACTIVITY CENTER AT THE LENNOX SHERIFF'S STATION. HE SERVED AS BOARD CHAIRMAN AND EMERITUS MEMBER OF L.A. FAMILY HOUSING, ON THE BOARDS OF LEGAL SERVICES AND THE AFRICA FOUNDATION AND CONTRIBUTED TO ORGANIZATIONS THAT PROVIDED NEEDED MEDICAL SERVICES FOR THOSE RETURNING FROM MILITARY SERVICE. HE'S SURVIVED BY HIS WIFE MICHELLE, HIS FOUR CHILDREN, JARED, DANIEL, SAM AND SARAH, TWO SIBLINGS, MATTHEW AND DEBRA, SEVERAL OTHER FAMILY MEMBERS. I ASK THAT WE ADJOURN IN HIS MEMORY. SECOND, WITHOUT OBJECTION, SO ORDERED. SUPERVISOR KNABE? 

SUP. KNABE: YES, MR. CHAIRMAN AND MEMBERS. I, TOO, YOU ALREADY ADDED ALL MEMBERS, BUT BRIAN WAS JUST AN OUTSTANDING MEMBER OF OUR COUNTY LIFEGUARD FAMILY AND TEAM, SERVING OVER 20 YEARS, AS SUPERVISOR KUEHL MENTIONED. HE WAS VERY ACTIVE THROUGHOUT THE GROUP AND DOING NOT ONLY THINGS ON THE BEACH AND SAVING MULTIPLE LIVES AND BEING PART OF OUR RESCUE BOAT OPERATION BUT ALSO MANY OUTSIDE ACTIVITIES INCLUDING THE JUNIOR LIFEGUARD PROGRAM. HE'S GOING TO BE SORELY MISSED BY ALL WHO KNEW HIM AND WORKED WITH HIM. AND, AGAIN, OUR THOUGHTS AND PRAYERS ARE WITH HIS MOM AND DAD AND THE ENTIRE FAMILY AND OUR LIFEGUARD FAMILY. ALSO WE ADJOURN IN MEMORY OF FRAN MINERD, LONGTIME WHITTIER RESIDENT, VOLUNTEER, PHILANTHROPIST, PASSED AWAY LAST WEEK AT THE AGE OF 30. BORN HERE IN 1929 LOS ANGELES COUNTY AND SPENT TIME IN THE UNITED STATES ARMY AIR FORCE AS A NAVIGATOR DURING WORLD WAR II. BECAME AN EXPERT IN THE STEEL INDUSTRY IN SOUTHERN CALIFORNIA. HE WAS VERY INVOLVED IN THE FRIENDS OF LIBRARY WHERE HE WAS A MANAGER FOR OVER 15 YEARS. HE WAS KNOWN AS A MAN WITH A BIG HEART, A STRONG SENSE OF COMMUNITY. HE WAS A DEVOTED FAMILY MAN WHO WAS DEDICATED TO SERVING OTHERS. HE LIKED NOTHING MORE THAN GIVING HIS TIME TO MAKE THE COMMUNITY A BETTER PLACE. HE IS SURVIVED BY HIS DEAR WIFE AND DEAR FRIENDS SELMA FOR 25 YEARS. SONS STEVEN, TIM, AND TRACY, 11 GRANDCHILDREN AND 14 GREAT GRANDCHILDREN. THOUGHTS AND PRAYERS ARE WITH SELMA AND THE ENTIRE FAMILY. ALSO JOINING IN WITH SUPERVISOR SOLIS ON THE ADJOURNMENT IN MEMORY OF THE ARTHUR MURIKAMI WHO WAS THE FATHER OF OUR INDUSTRY SHERIFF'S STATION, CAPTAIN TIM MURIKAMI. ALSO THAT WE ADJOURN IN MEMORY OF [NATHAN] "LITZO" DISTEFANO. HE PASSED AWAY AT THE AGE OF 94 ON JANUARY 12TH. HE WAS A VERY PATRIOTIC MAN WHO SERVED IN WORLD WAR II WHERE HE MET HIS WIFE JANET. THEY WERE MARRIED FOR 66 YEARS. PROUD SICILIAN WHO LOVED PLAYING HIS MANDOLINS AND WAS A VERY ACTIVE MEMBER OF THE SONS OF ITALY. HE WAS ALSO AN AVID GOLFER AND A LONG TIME MEMBER OF THE LAKEWOOD COUNTRY CLUB A COUNTY COURSE AND HE IS SURVIVED BY HIS TWO SONS TONY AND LEONARD, TWO DAUGHTERS, NINE GRANDCHILDREN AND EIGHT GREAT GRANDCHILDREN. TRULY MISSED. THOSE ARE MY ADJOURNMENTS, MR. MAYOR. SECOND. 

SUP. KNABE: I DO HAVE AN URGENCY READ. WITHOUT OBJECTION, SO ORDERED. 

SUP. KNABE: THANK YOU, MR. MAYOR. I DO HAVE AN URGENCY READ-IN. I WOULD LIKE TO MOVE URGENCY. AND THAT IS AS WAS MENTIONED, OCEAN LIFEGUARD SPECIALIST BRIAN KUTIL DIED IN THE LINE OF DUTY DURING A TRAINING EXERCISE. IN ORDER TO ACCOMMODATE THE DEPARTMENT FLAG CEREMONY AND MEMORIAL SERVICES, IT IS APPROPRIATE FOR THE BOARD IN THIS CIRCUMSTANCE TO TAKE THE FOLLOWING ACTION: MOVING THAT WE WAIVE THE PARKING FEES FOR 100 VEHICLES AT THE FISHERMAN'S VILLAGE PARKING LOT FROM 8 A.M. UNTIL NOON ON THURSDAY, JANUARY 22ND. WAIVE PARKING FEES FOR APPROXIMATELY 400 VEHICLES AT THE DOCKWEILER YOUTH CENTER AT VISTA DEL MAR IN LOS ANGELES FROM 8 UNTIL 2 TO INCLUDE THE ADJACENT GRAND AVENUE LOT FOR OVERFLOW PARKING IF NECESSARY. WAIVE FEES IN THE AMOUNT OF $220 FOR THE USE OF THE MULTI-PURPOSE ROOM AT DOCKWEILER YOUTH CENTER ON SATURDAY, JANUARY 24TH FROM 8 UNTIL NOON FOR FAMILY MEMBERS AND GUESTS DURING THESE MEMORIAL SERVICES ON THE BEACH. 

MARK SALADINO, COUNSEL: MOVE URGENCY. SUPERVISOR KUEHL I -- I MOVE URGENCY. 

SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR SUPERVISOR KUEHL. WITHOUT OBJECTION, SO ORDERED. I WOULD ALSO LIKE TO MOVE WE ADJOURN IN MEMORY OF TRAVIS MARTON SANTA CLARITA VALLEY WHO TRAGICALLY PASSED AWAY AT THE AGE OF 23. HE WAS A RECENT GRADUATE OF THE UNIVERSITY OF CALIFORNIA SANTA CRUZ IN BIOENGINEERING DEGREE AND WORKED AT THERMAL SCIENTIFIC AS A RESEARCH ASSOCIATE. SHARON ENOS, RETIRED DISPATCHER FROM THE LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. RICHARD WARCHOL, LONGTIME RESIDENT OF SANTA CLARITA VALLEY. SERVED AS A MILITARY POLICE OFFICER IN THE UNITED STATES ARMY. WORKED FOR 36 YEARS AS A CRAFTSMAN FOR GENERAL MILLS. HE PASSED AWAY IF HE AGE OF 88. CLIFFORD RAY ROWLEY, LONGTIME RESIDENT OF LANCASTER, PASSED AWAY AT THE AGE OF 76. HE WAS EMPLOYED WITH THE ACTON SCHOOL DISTRICT FOR OVER 20 YEARS. GERALDINE VIDOVICH PASSED AWAY AT THE AGE OF 87. A DOCTOR WAS A MEMBER OF THE AMERICAN PHARMACEUTICAL ASSOCIATION AND ACTIVE WITH THE UNIVERSITY OF SOUTHERN CALIFORNIA'S PHARMACY ALUMNI ASSOCIATION ALONG WITH HER CHURCH, MARY STAR OF THE SEA AND OUR LADY OF CHARITY NATIONAL CATHOLIC ALUMNI CLUB. AND ANELIS NICK MOSICH, LONG TIME PROFESSOR AT THE UNIVERSITY OF SOUTHERN CALIFORNIA SCHOOL OF ACCOUNTING, PASSED AWAY AT THE AGE OF 86. AFTER HE SERVED IN THE UNITED STATES ARMY AFTER EARNING HIS DOCTORATE DEGREE UNTIL HE WAS HONORABLY DISCHARGED IN 1955. HE THEN SPENT NEARLY 30 YEARS TEACHING AT THE UNIVERSITY OF SOUTHERN CALIFORNIA, WELL RESPECTED AS A CONSULTANT, EXPERT WITNESS, AND WAS AUTHOR, CO-AUTHOR OF SEVERAL ACCOUNTING TEXTBOOKS. MY ADJOURNMENT MOTIONS, SECONDED BY SUPERVISOR KUEHL. SO ORDERED. AND WE HAVE PUBLIC COMMENT. CALL UP MR. ROBERT LUCAS? MISS IRENE PANG. MR. HERMAN HERMAN. MR. ARNOLD SACHS. AND THEN THEY WILL BE FOLLOWED BY MR. PREVEN AND MR. SERRANO. 

ROBERT LUCAS: GOOD AFTERNOON. YOUR SHIRT REMINDS ME OF LIME SHERBET. MAN IT JUST MAKES ME HAPPY. 

SUP. ANTONOVICH, MAYOR: IT MATCHES MY SOCKS. 

ROBERT LUCAS: YOU KNOW, I MISSED OUT BY TALKING ABOUT THE S-1 BECAUSE I DIDN'T PROCESS THE QUESTIONNAIRE RIGHT IN THE EXECUTIVE OFFICE. LET ME GIVE YOU A LITTLE HINDSIGHT HERE BECAUSE I LISTENED. I WAS IMPRESSED BY THE SHERIFF'S PRESENTATION. THAT WAS IMPRESSIVE. HE OWES WHOEVER PREPARED THAT FOR HIM A GOOD LUNCH BECAUSE I WAS IMPRESSED. IT WAS AMAZING. THE THING ABOUT IT WAS: THE OTHER CUSTODY PERSON, THE WOMAN, I'M SURE SHE'S A SHERIFF, SHE MISSED A COUPLE OF THINGS IN HER PRESENTATION. NOT ONCE IN THE CAMERA POWERPOINT PRESENTATION WAS N.C.C.F. GIVEN CAMERAS. LET ME TELL YOU A LITTLE BIT OF MY PERSONAL EXPERIENCE. WHENEVER THEY HAD AN INCIDENT AT THE MAIN COUNTY JAIL, THAT GOT OUT OF HAND. THEY CORRALLED WHATEVER THE PROBLEM WAS, WHATEVER THE DISTURBANCE WAS AND THEY SHIPPED THEM TO N.C.C.F. GO UP TO THE N.C.C.F. FACILITY. WALK AROUND IN THEM PODS. YOU WANT TO SEE WHAT A TREACHEROUS SITUATION IS? THEY DON'T ENTER TO RELIEVE A SITUATION. THEY STAND OUTSIDE AND FIRE WEAPONS IN THERE. I'VE BEEN A PART OF IT. I HAVE SCARS FROM IT. I'M NOT SAYING THAT SHE WITHHELD THIS INFORMATION. I'M JUST SAYING SHE WASN'T GIVEN EVERYTHING THAT SHOULD HAVE BEEN TO BE GIVEN TO YOU PEOPLE. WITH THESE SCANNERS, THE SCANNERS, REALLY? LET ME FOCUS YOU A LITTLE BIT ON WHERE THE PROBLEM IS. IT'S NOT PEOPLE COMING IN AND OFF THE STREETS, IT'S THROUGH THE PROBATION WITH THIS FLASH NONSENSE. YOU DON'T THINK THAT THEY DON'T PLAN TO GO IN THERE WITH A 10-DAY FLASH WITH A PURPOSE? COME ON. WE'RE DEALING WITH PEOPLE WHO WERE THREATENED ON THE STREET UNLESS YOU DO THIS. THAT'S HOW THEY'RE GETTING IN THERE. DON'T WORRY ABOUT THE PEOPLE COMING IN GETTING ARRESTED BECAUSE BELIEVE IT OR NOT, THEIR LIVES ARE GETTING SAVED WHEN THEY GET ARRESTED. WORRY ABOUT THE PLANNED PEOPLE TAKING IT IN THERE. 

ERIC PREVEN: YES, IT'S ERIC PREVEN AND I'LL PICK UP BRIEFLY ABOUT THE SCANNERS BECAUSE IT'S WHERE I WAS TERMINATED EARLIER IN MY COMMENTS. IT'S ERIC PREVEN, THE COUNTY RESIDENT FROM DISTRICT 3 AND CANDIDATE FOR THE CITY COUNCIL DISTRICT 2. SO THOSE SCANNERS, SIR, I'VE TESTED THEM OUT MYSELF. I WENT OVER THERE, NOT AS AN INMATE OR PROSPECTIVE INMATE, AS A COUNTY WATCHDOG. AND I LOOKED AT THEM. AND THEY SLIDE PEOPLE THROUGH SIDEWAYS. THEY ARE NOT ESPECIALLY EFFICIENT, TO BE HONEST. AND THEY ARE SEVERELY PROBLEMATIC. AND I WOULD LOOK VERY CLOSELY AT NOT EXPANDING USE OF THEM. IF THERE ARE SOME APPLICATIONS THAT MAKE A LOT OF SENSE, WE SHOULD CONSIDER IT. BUT THEY BOG THINGS DOWN. THEY'RE NOT IDEAL FOR A NUMBER OF REASONS. AND THEN IT JUMPS TO THE QUESTION OF THE CAMERAS ON THE WALLS. I THINK WE'VE ADDRESSED THE BLIND SPOT, WHICH IS VERY, VERY IMPORTANT. BUT THE REAL TURN THERE HAS TO DO WITH THE OFFICER-WORN LAPEL CAMERAS, WHICH IS THE STATE-OF-THE-ART AND SHOULD BE IMPLEMENTED. AND OUR REACTION, UNFORTUNATELY, TO THIS PROCESS WAS TO DO A 600-PAGE REPORT THAT WAS INCREDIBLY THOROUGH, SO THOROUGH THAT YOU COULDN'T ACTUALLY SEE WHAT THE CONCLUSION WAS. THE CONCLUSION WAS LET'S NOT DO IT. BUT THE RIGHT RESPONSE IS LET'S SERIOUSLY CONSIDER DOING IT BECAUSE IT'S CHEAPER, BETTER AND MAKES A LOT MORE SENSE. AND THEN THERE'S THE MATTER OF THE CASE INVOLVING LEGAL BILLS. AND I DID REFERENCE IT EARLIER. AND I THINK THAT THIS IS SO IMPORTANT. THAT THE BOARD OF SUPERVISORS ACKNOWLEDGE THAT THEY ARE THE CLIENT IN THIS CASE. AND THAT THE PRIVILEGE TO THEIR ATTORNEYS TO SEQUESTER LEGAL BILLS IS A BIG MISTAKE. IT'S A TERRIBLE MISTAKE. WE OUGHT TO SHOW HOW WE'RE FIGHTING THESE BILLS AND DEFEND HONORABLE BEHAVIOR AND -- LESS HONORABLE BEHAVIOR SHOULD NOT BE DEFENDED WITH NO CEILING ON EXPENSE. THAT'S JUST NOT APPROPRIATE. AND IN CONCLUSION, I THINK IT'S VERY NICE THAT SOMEBODY PUT UP A REWARD TODAY TO CATCH SOMEBODY FOR $10,000. WE OUGHT TO DO THAT WHERE NECESSARY. WE SHOULD FIND A POLICY THAT APPLIES TO ALL CRIMES BECAUSE ACROSS THE STREET THEY'RE DOING SUCH HIGH REWARDS THAT IT DOESN'T SEEM RELEVANT. WE HAVE OF MORE SERIOUS [INAUDIBLE] 

IRENE PANG: I'M IRENE. I CONCERNED ABOUT IN THE COUNTY FOR THIS DAY SAN FRANCISCO AND SEATTLE AND ORANGE COUNTRY HAVING CAUGHT UP IN THE ECONOMIC SYSTEM AND SET IN THE OTHER GOVERNMENT MATTERS SAME AS THE UNITED STATES BECAUSE MANY HUMAN BEINGS SUFFER FROM REVELATION OF THE STUDENT OF THEIR PERSONAL PROPERTY. ESPECIALLY THEIR FINANCIAL. AND THEIR REAL PROPERTY. MY FAMILY MEMBERS IN THE ASSOCIATION WORKING HARD AND WELL TOGETHER WITH L.A. COUNTY GOVERNMENT THAT DIRECTLY AFFECT THE L.A. COUNTY GOVERNMENT GIVE THEM TORNADO. THEN AFTER MANY PERIOD THEY INVESTIGATE AND THEIR PLAN IS TIED TO L.A. COUNTY SUPERVISOR AND THE POSITION BEGAN WITH THAT TIE BEGAN IN JANUARY. IN 2015. AND THE PUBLIC KNOW THAT THEN SUPERVISOR END UP PAYING THE WORKING HARD AND THE ABILITY. HONEST AND HER FAMILY MEMBER AND EXCELLENCE THE SITUATION SHOW ON THE STATUE OF A U.S. TREASURE. WE AND U.S. CITIZEN WARN U.S. THAT DEFENSE WELL AND THEIR OWN NATIONAL AUTHORITY POWER. AND ALL IS THE SYSTEMS WE NEED THEY ARE FAITHFUL AND WORKING HARD AND EXCELLENCE MATTERS TO PROTECT THE NATION U.S. OUR NATION HAD TO PUNISH THOSE PATIENTS THEY HAVE BEEN DONE TO UM REVELATION TO THEIR WORKING HARD STAFF AND PROTECT. 

SUP. ANTONOVICH, MAYOR: [SPEAKING CHINESE]. MR. SERRANO? 

DAVID SERRANO: GOD IS THE FATHER AND THE SON AND THE HOLY SPIRIT, THE HOLY TRINITY IS THE ONE AND ONLY GOD. THE HOLY TRINITY IS THE CREATOR OF HEAVEN AND THE UNIVERSE. REALITY IS THE LORD JESUS CHRIST CREATED HEAVEN AND THE UNIVERSE, AMEN. THERE WILL BE A BLOOD MOON LUNAR ECLIPSE ON APRIL 4, 2015 A.D. AND THEN THERE WILL BE A SECOND BLOOD MOON ON SEPTEMBER 28, 2015, ANNO DOMINI. LIKE IT IS RECORDED IN THE HOLY BIBLE IN THE BOOK OF REVELATION, THE HOLY INFINITE TRINITY PROPHESIED THERE WILL BE A GREAT EARTHQUAKE ON THE SOUTHERN CALIFORNIA SAN ANDREAS FAULT THAT DEVASTATES REGIONS OF LOS ANGELES COUNTY AS A BIG STORM WITH THUNDER AND LIGHTENING DARKENS THE SKY IN THIS YEAR THAT THE MOON WILL BE TURNED THE COLOR BLOOD RED AND THE HORIZONTAL DISPLACEMENT WILL CAUSE THE MOUNTAINS AND ISLANDS TO BE MOVED OUT OF PLACE. LOS ANGELES IS THE CITY OF ANGELS. ONE OF THE THINGS REVELATION 10:1-5 IS ABOUT IS HOW THE PACIFIC AND NORTH AMERICAN TECTONIC PLATES COME INTO CONTACT AT THE SAN ANDREAS FAULT IN LOS ANGELES COUNTY, THE PACIFIC PLATE IS ALMOST ENTIRELY UNDER THE PACIFIC OCEAN AND THE NORTH AMERICAN PLATE INCLUDES THE REST OF CONTINENTAL NORTH AMERICA. SOME OF THE EVENTS REVELATION 6:12-6:17 PROPHESIED IS THAT THE MOON WILL BE TURNED THE COLOR BLOOD RED, A GREAT STORM WILL DARKEN THE SKY, AND LIKE IT IS WRITTEN IN JEREMIAH CHAPTER 24. THE JEWS ARE CALLED FIGS AND THE GREAT EARTHQUAKE IN LOS ANGELES COUNTY WILL CAUSE HORIZONTAL DISPLACEMENT ON THE SAN ANDREAS FAULT AND THE MOUNTAINS AND ISLANDS WILL BE MOVED OUT OF PLACE, AMEN, HALLELUJAH, PRAISE THE LORD. REALLY QUICKLY JUST TO TALK ABOUT 1857 MAGNITUDE 7.9 EVENT BROKE AND RUPTURED MORE THAN 225 MILES OF THE FAULT FROM PARKFIELD, CENTRAL CALIFORNIA WITH HORIZONTAL DISMENT. 

SUP. ANTONOVICH, MAYOR: THANK YOU. 

DAVID SERRANO: PRAISE THE LORD, HALLELUJAH. 

SUP. ANTONOVICH, MAYOR: I WOULD ALSO STATE IF YOU'RE GOING TO QUOTE THE BIBLE, QUOTE IT CORRECTLY. LOS ANGELES COUNTY IS NOT MENTIONED IN THE BIBLE AS ARE THE PLATES. IT'S NOT IN THE BOOK OF REVELATION. SO DON'T BE A FALSE PROPHET, OKAY? MR. HERMAN HERMAN. 

HERMAN HERMAN: OKAY. SO THEN WE'RE TALKING ABOUT HERE LAWMAKERS. 

SUP. ANTONOVICH, MAYOR: AND JOSHUA JOSHUA. 

HERMAN HERMAN: U.S. SUPREME COURT SAID THAT THE GOVERNMENT SHOULD NOT REFRAIN YOUR CONSTITUENTS FROM CENSORING IN ADVANCE WHEN IT COMES TO OR PROHIBITING SPEAKERS FROM AGENDA ITEMS LIKE YOU DID WITH MYSELF UNDER ITEM 1-S. BUT FROM REFERENCING A SPECIFIC POINT, IT'S ALL ABOUT SPEECH. CENSORING OUR RIGHT TO BE HEARD. AND I CAME UP WITH THIS VERY IDEAL POINT, THAT LOCAL GOVERNMENT -- AND IT'S THE DEFINITION, GOVERNMENT CORRUPTION -- HAS BEEN DEFINED AS ABUSE OF PUBLIC POWER FOR PRIVATE AND PERSONAL GAIN. AS YOU LAUGH AT THESE POOR FOLKS THAT STOOD HERE, I COULDN'T BELIEVE THAT YOU'RE LAUGHING IN THEIR FACE AND MAKING LITTLE JOKES ABOUT THEIR MENTAL EXCUSES. NO ONE SHOULD BE SUBJECTED TO MENTAL ABUSE LIKE THAT FROM ANYONE. LET THEM HAVE THEIR POINT AND SAY, SUCH AS I DO TODAY. AND FURTHER POINT, YOU TAKE ADVANTAGE OF SERVICES. YOU STEAL FUNDS OUTRIGHT LIKE YOU DO HERE AND ARNOLD SACHS WILL POINT OUT AND THEY MAY ALSO USE THEIR POSITIONS TO GAIN FAVORS UNFAIRLY LIKE JOSE HUIZAR, THIS IS FROM THE CITY OF L.A. NOW. I CAN'T SAY NOTHING NEGATIVELY HERE BECAUSE SO FAR YOU'VE ALL DONE A COMMENDABLE JOB OTHER THAN MR. RILEY WHO BUILT A GARAGE INTO A HOME. GARAGE CONVERSION I DID NOT FORGET. AND USING PUBLIC FUNDS. SO THE VICIOUS CYCLE RESULTS TO GOVERNMENT RAISING TAXES TO MAKE UP FOR SUCH LOSSES, IN TURN TO MORE CORRUPTION. KEEP YOUR SIX SECONDS. THANK YOU. HOLLYWOODHIGHLAND.ORG, JOHN WALSH. 

SUP. ANTONOVICH, MAYOR: MR. SACHS? 

ARNOLD SACHS: THANK YOU, GOOD AFTERNOON. ARNOLD SACHS. AND A COUPLE WEEKS AUTO AGO, I DID MENTION THE TIFIA PROGRAM THAT METRO RUNS. I WAS ACTUALLY WRONG. I AM HERE TO ADMIT I WAS WRONG. THAT THE 3 PERCENT LOCAL RETURN WITH THAT PROGRAM IT NOT ONLY INCLUDE TIFIA PROGRAM, IT'S LIKE THIS MEASURE 1-B PROPOSITION FUND, THEY MAY NOT GET THAT FROM METRO PROJECT BUT THEY ARE GETTING STATE FUNDS. SO THE THREE PROJECTS THAT TOTAL $4 BILLION, THEY'RE GETTING 3 PERCENT OF ALMOST A TOTAL OF $4 BILLION. AND IF YOU LOOKED AT THE PROJECTIONS FOR MEASURE R FUNDING, THAT THE METRO BOARD DECIDED ON, IT WAS $1.3 BILLION A YEAR THAT THEY WERE PROJECTING IT TO RAISE. IF YOU LOOKED AT THE 2007-2008 BUDGET REPORTS, THEY WERE MAKING ABOUT $750,000 -- $750 MILLION. LESS THAN HALF OF WHAT THEY PROJECTED FOR 2009. SO HERE'S A QUESTION FOR YOU. THERE'S A HIGH SPEED RAIL BEING INTRODUCED IN CALIFORNIA. DO THEY HAVE THE SAME KIND OF PROJECT SCOPE WHERE IT'S 3 PERCENT OF HIGH SPEED RAIL MONEY GOING BEING CHARGED TO THE COMMUNITIES? AND IF NOT, WHY NOT? IF METRO CAN SEE FIT TO CHARGE 3 PERCENT ON FEDERAL AND STATE FUNDS INSTEAD OF DEDUCTING THEM FROM THE COST, WHY DOESN'T THE STATE DO THE SAME THING? DO WE HAVE ANY ELECTED STATE REPRESENTATIVES WHO USED TO BE THERE? WHY YES, YOU WERE THERE, FEDERAL GOVERNMENT, YOU USED TO BE THERE. YOU WERE THERE. HOW DOES THAT WORK? HOW ARE THEY ALLOWED TO BE SUCH CHEAP CROOKS ON METRO AND GET AWAY WITH IT? DON'T YOU FEEL RESPONSIBLE TO YOUR CONSTITUENTS TO ASK THOSE QUESTIONS? I'D LIKE TO TALK A LITTLE BIT ABOUT THE HERBICIDE AND THE GRAFFITI ABATEMENT BUT THAT MAKES MR. KNABE UPSET. I'LL SAVE IT FOR NEXT WEEK. 

SUP. ANTONOVICH, MAYOR: YES, SIR. 

MR. JOSHUA: I'M PRESENTING TO YOU UNDER MY PEN NAME TODAY OF MR. JOSHUA AND PARTLY DISGUISED BECAUSE OF ALL THE RETALIATIONS I'VE BEEN SUBJECTED TO FROM L.A. COUNTY EMPLOYEES FOR BLOWING THE WHISTLE ON A CORRUPTION IN THE L.A. COUNTY. THE TITLE OF MY LITTLE SHORT PRESENTATION HERE IS BLACK LIVES DO NOT MATTER TO THIRD REICH NAZIS AND THEIR HOUSE NEGRO POLITICIANS. GEORGE BUSH'S OBAMA IS STEVE COOLEY'S JACKIE LACEY. I PUBLISHED A REPORT, OR REPORT WAS PUBLISHED ON THE INTERNET RADIO SHOW FOR THE JUSTICE CHANNEL ABOUT THE LOS ANGELES COUNTY DISTRICT ATTORNEY'S OFFICE CAMPAIGN ABOUT TWO YEARS AGO. YOU CAN HEAR THIS INTERNET RADIO SHOW AT THE JUSTICE CHANNEL ON BLOG TALK RADIO. THAT ADDRESS IS WWW.BLOGTALK RALDIO.COM/ELM. LOOK FOR THE TITLE CANDIDATES FOR DISTRICT ATTORNEY TOWN HALL COMMENTARY. I'VE ALSO PUBLISHED AN ARTICLE TO THE JUSTICE CHANNEL BLOG ABOUT THIS AT THE JUSTICE CHANNEL.BLOGSPOT.COM. IN 2014, IT APPEARS THAT JACKIE LACEY IS FOLLOWING THE RACIST LEGACY OF STEVE COOLEY. SHE STILL HAS NOT TRIED TO FILE ANY CHARGES AGAINST L.A. COUNTY SHERIFF'S DEPUTIES. SHE HAS DONE NOTHING FOR THE MURDER OF EASLE FORD BY HISPANIC L.A.P.D. PIG. AND THE WOMAN IN THE CALIFORNIA HIGHWAY PATROL BEATING CASE. ALL OF THESE WERE VERY HIGH PROFILE CASES. SOME OF THE BIGGEST SELLOUT PLANTATION HOUSE NEGROES ARE THE ONES WHO WORK IN OUR COURTS, PRACTICE LAW, AND SITTING JUDGES. THEY KNOW THE LAW AND JUST LIKE THE SUPREME COURT JUDICIAL HOUSE NIGGER CLARENCE THOMAS REFUSES TO ENFORCE THE LAW FOR THE AMERICAN NEGRO THEY WILL NOT SPEAK OUT FOR ATROCITIES THAT'S BEING PERPETRATED AGAINST THE AMERICAN NEGRO IN THE JUDICIAL SYSTEM AS WELL AS ALL LAW ENFORCEMENT AGENCIES. 

SUP. ANTONOVICH, MAYOR: THANK YOU, MR. JOSHUA. 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM NO. CS-1, CONFERENCE WITH LEGAL COUNSEL REGARDING SIGNIFICANT EXPOSURE TO LITIGATION AND ITEM NO. CS-2 CONFERENCE WITH LABOR NEGOTIATORS SACHI HAMAI AND DESIGNATED STAFF AS INDICATED ON THE POSTED AGENDA. THANK YOU. 
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